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1Software Installation InstructionsAppendix B.  Part Building Limitations

Software Installation Instructions

Installing Buildstation 5.0

Overview

This section of the document tells you how to:

� Install the Buildstation 5.0 software from the CD.

� Obtain and install your license.

� Verify that your new installation is working properly.

Installing the New Software

As with most Windows software, Buildstation 5.0 comes with an automated
setup routine. During installation, this setup routine performs automatic
checks on your system, asks a series of questions about how you want to
configure Buildstation 5.0, and, based on your answers to these questions,
copies several files to the SLA system�s hard disk. It then decompresses the
files, writes data to areas of your system�s registry, and creates shortcuts to
the program for your Windows �Start� menu.

Your SLA system may be running Windows NT 3.51 or Windows NT 4.0.
Buildstation 5.0 runs equally well under either operating system. Regardless
of which operating system is running, the installation steps are the same.
The main differences relating to program installation and program execution
between the two versions have to do with where they store links to the
executables. Whereas Windows NT 3.51 uses Program Manager and
Program Groups, Windows NT 4.0 uses the Taskbar and shortcuts for
storing the links.

The following instructions, then, will serve as instructions for both systems.

�IMPORTANT!�
DO NOT OVERWRITE the installation of the Buildstation 4.1.1 software that
already resides on your SLA when you install Buildstation 5.0. You should
keep your existing setup intact so that it can function as a �backup� in the
event of any problems with the newly installed Buildstation 5.0. The new
software will co-exist peacefully with the version of the software that currently
resides on your SLA.
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�NOTE�
If you normally use a virus protection program on your PC, turn it off, or
override its monitoring of the system before installing Buildstation 5.0. After
Buildstation 5.0 installation is complete, restart your virus protection program.

1. Insert the CD labeled �Buildstation 5.0 SLA Control Soft-
ware for Windows NT� into your SLA�s CD-ROM drive.

2. If you are running Windows NT 3.51, go to the Windows
Program Manager, and click �File > Run��, or, if running
Windows NT 4.0, click on the Windows �Start� button, in
the lower-left corner of the Windows �Taskbar� then
highlight and click the �Run� command.

3. Click inside the �Open� box and type the command
�d:\Setup.exe� where �d� is the letter designation for your
CD ROM drive. (Alternatively, you can use the �Browse�
button to browse to the �Setup.exe� file.) Click the �OK�
button. This launches the Buildstation Setup program.

4. When the �Welcome� screen appears, click the �Next�
button.

�IMPORTANT!�
Please read Step 5 carefully. It is very important that you preserve your
existing installation of Buildstation 4.1.1 so that if any problems occur with
the new software, you can re-activate your older version of the program and
continue to produce parts.

5. When the �Choose Destination Location� screen appears,
notice that �C:\WinSLA5� appears as the default �Destina-
tion Folder.� Accept this location by clicking the �Next�
button.

If you must alter the destination folder, make sure you do
not enter the name of the folder that contains your exist-
ing Buildstation 4.1.1 installation. Usually, the name of the
Buildstation 4.1.1 installation folder is �C:\WinSLA.�

6. When the SLA Machine Selection window appears, click
the radio button next to your SLA machine type, then click
�Next.� Answer any other question(s) about your SLA
machine that may be presented.
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7. When the �Select Program Folder� screen appears, click
�Next.� By default, this will place a program icon in the
�Buildstation5� program group which will aid in the
launching of the Buildstation 5.0 program.

8. When the �Start Copying Files� screen appears, click
�Next� to begin the transferring and installing the program
files.

9. At the conclusion of all activity, the �Setup Complete�
screen appears. Click �Finish.�

Preserving Your Calibration Files

The next set of steps are very important in preserving your machine specific
calibration data.

1. Copy (not Move) the �params.dat� file in �C:\WinSLA� into
the �C:\WinSLA5� folder. Make sure you leave a copy of
the �params.dat in the existing �C:\WinSLA� folder.

2. Copy (not Move) all the �.cal� and �.geo� files in
�C:\WinSLA\Config� folder into the �C:\WinSLA5\Config�
folder. Make sure you leave a copy of all the �.cal� and
�.geo� files in the existing �C:\WinSLA\Config� folder.

Your software is now installed and you are ready to obtain and install your
license file.
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Obtaining and Installing Your Buildstation 5.0 Software
License

�IMPORTANT!�
DO NOT ATTEMPT TO LAUNCH Buildstation 5.0 until you have installed the
correct license file. Obtaining a license is a multi-step process. Before
starting, make sure you have successfully completed the steps to install the
software.

1. Open a Command Prompt (DOS window). In Windows NT
3.51, you will find the �MS-DOS Prompt� icon in the �Main�
program group of Program Manager. In Windows NT 4.0,
you will find the �Command Prompt� icon on the Taskbar�s
�Start� menu.

2. Type the command �cd c:\winsla5� and press <Enter>. (If
you did not accept the default folder �C:\WinSLA5� as
recommended in Step 5 of the installation instructions
above, then you must use the DOS �cd� command to
change to the folder where you installed Buildstation 5.0
before continuing.)

3. Type the command �lmutil lmhostid� and press <Enter>.
This command queries your system and returns its unique
host identification code.

4. COPY THE CODE DOWN. Later, you will install the license
file on this machine. License files are machine-specific. If
you are installing Buildstation and requesting license files
for more than one machine, take steps now to be able to
identify this machine later by its unique host identification
code.

5. REPEAT Steps 1 through 4 of this procedure for each SLA
that will be running Buildstation 5.0.

6. Having obtained the "Host-ID�s" for the processors you
wish to license, find the Authorization Code shipped with
your software pack, and visit the licensing section of the
3D Systems' website at www.3dsystems.com and follow
the instructions to license your installation.

Your licence file will be emailed to you.
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7. Copy the appropriate license file to the �C:\WinSLA5�
folder for each machine.

8. Make sure that the name of the license file is
�License.dat.�

You can now launch Buildstation 5.0.

Verify and Complete the Installation of Your New
Software

Once the software is successfully installed and licensed, you will have a
�Buildstation 5� program item in your Windows� Start menu or program group.

1. Double-click this program item to launch Buildstation 5.0.

2. From the menu bar, select �Setup > Choose Geometric
Calibration File��

3. From the Choose Geometric Calibration File dialog, select
the latest .geo file in the �C:\WinSLA5\Config� folder.

Call Randy Doyle at (661) 295-5600, extension 2499, or via email at
doyler@3dsystems.com, if you have any questions or problems with installa-
tion or licensing. If you need help, please contact Randy Doyle at 3D Sys-
tems; (661) 295-5600 extension 2499.

�IMPORTANT!�
Please report any problems you have with the program or this document to
3D Systems� Senior SLA Product Specialist, Mr. Randy Doyle at (661) 295-
5600, extension 2499.or via e-mail at doyler@3dsystems.com. Every effort
will be made to assist you as promptly as possible.
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Buildstation Control Software User’s Guide

Before You Begin

SLA Buildstation Documentation

This user�s guide provides detailed information you will need to operate the
3D Systems� Buildstation Software and to build parts on your SLA 350, SLA
500, SLA 3500, SLA 5000 or SLA 7000 Solid Imaging system.

In this guide you will find:

� How to launch the Buildstation program

� A complete explanation of the Buildstation�s features and functions,
and user interface including menus, dialogs and Toolbar buttons

� How to setup the Buildstation before part building

� How to start building parts on the SLA

� An explanation of additional features and options

� How to troubleshoot Buildstation problems

Symbols Used in this Guide

This symbol designates the accompanying texts or figures
as a NOTE, CAUTION, or WARNING.

When accompanied by the word "NOTE", the text and symbol
are meant to call attention to a practice whose
implementation can save time or prevent subsequent
inconvenience to the user.

When the symbol is grouped with texts labeled "CAUTION",
the intention is to point out a condition or practice otherwise
not covered by another type of symbol that presents a hazard
to equipment that may be in the immediate area.

(Continues on the following page...)
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If the word "WARNING" is listed with the symbol, the texts
highlight a practice or condition otherwise not covered by
another type of symbol that presents a hazard to both
equipment and personnel that may be in the immediate area.

Laser and Chemical Safety

Thoroughly review all laser and chemical (including resin) safety procedures
located in Appendix C of the SLA User's Hardware Reference Manual, prior
to operating the SLA.

Cursor Pointer and Mouse Conventions

Cursor and mouse conventions are described below to facilitate proper
operation of the Buildstation software.

Cursor

The cursor is the entry point for a computer. In character-based software, a
blinking vertical bar is typically seen on the screen. The cursor is the location
where text or number commands are to entered from the keyboard.

Pointer

The pointer is the arrow that moves about on the screen as the mouse is
moved. The pointer can also take on forms other than an arrow depending
on where it is being placed on the screen. The pointer, in contrast to the
cursor, does not blink. Placing the pointer on an object then clicking one of
the mouse buttons will command that object to perform a task.

Mouse

3D Systems Buildstation software operates by using the mouse buttons.

� The left mouse button is the primary button.

� "Point" means to position the mouse pointer, which appears as an
arrow, until the tip of the pointer rests on the object desired for
selection.

� "Click or press" means to press and release the left mouse button
while pointing to an object with the mouse pointer arrow.

(Continued from preceeding page...)
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� "Drag" means to press and hold the left mouse button while pointing
to an object, then moving the mouse pointer arrow and object
together across the screen.

Mouse uses are described in each separate application section of this user
guide.

Windows NT® 4.0

All the screen shots in this User�s Guide were made using Buildstation 5.0
running on Windows NT 4.0. The screens for users on Windows NT 3.51 are
slightly different.

Last Minute Changes

All attempts have been made to make this document as complete and
accurate as possible. Refer to the Read This First and Release Notes
shipped with the software for late-breaking information that could not be
included in this printed book.

3D Systems Support Services

Product Support Within the United States and Canada

3D Systems Incorporated
3D Plus Customer Support Center
805 Falcon Way
Grand Junction, CO 81502
Telephone: (800) 793-3669

Product Support Elsewhere Throughout the World

International Customers, consult your local 3D Systems Sales Office for the
address and phone or FAX numbers of your regional 3D Systems Customer
Support Center.

3D Systems Internet Website

3D Systems' worldwide website is at www.3dsystems.com, and through it
you can access 3D Systems Customer Support.
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10 Buildstation Control Software User's Guide

Getting Started

Introduction to SLA Buildstation Software

The Buildstation Software runs on the SLA system�s computer controller and
allows the operator to set-up, modify, and control part building on the SLA
system. When the operator completes the set-up and commands the system
to build, the SLA Buildstation computer controls all SLA system�s functions
and sub-systems during the build.

The Buildstation software operates in the user-friendly Windows NT environ-
ment and provides support for either version 3.51 (SP5) or version 4.0 (SP3)
of that operating system.

To operate the Buildstation software, you will need to be familiar with the
Windows environment including icons, toolbars, buttons, and menus. Addi-
tionally, you will need to know how to use the mouse and keyboard to select
options and enter information into the system. Refer to Appendix B of this
user�s guide for more information on the Windows NT operating system.

Transferring a Build File to Your SLA System

Before you can build parts on your SLA system, you must first transfer the
desired build file (BFF) created on the 3D Lightyear File Preparation Soft-
ware workstation, to your SLA system controller.

These files are usually stored in a special folder on the Buildstation controller
(c:\Winsla5\Bff), but may be stored elsewhere in your operation.

Any method that gets the BFF file from the workstation computer to the
Buildstation controller will work, but typically users transfer build files through
the local area network (LAN) using the Windows NT Explorer, or similar
program.

Because the actual method may differ from facility to facility, we recommend
you consult with your supervisor or network manager to learn how it is best
done in your operation.
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Launching the Buildstation Program

There are many ways to launch programs in Windows NT. We explain two
methods below.

NOTE!
These instructions detail how to launch the program when
using Windows NT 4.0.

If a shortcut has been placed on the Windows Desktop, the easiest way to
launch the program is to double click the desktop shortcut icon (Figure 1).

Figure 1. Desktop Shortcut Buildstation Icon

If there is no icon on the desktop:

1. Press the Windows "Start" button (Figure 2). This will
open the "Start" menu.

Figure 2. Windows Start Button

2. Move the mouse so that the mouse pointer points to the
"Programs" folder icon. This will open the "Programs"
menu.

(Continues on the following page...)

Cuser guide 5.0 body1.p65 6/14/99, 10:39 AM11



12 Buildstation Control Software User's Guide

3. Again, move the mouse pointer to the "Buildstation5"
folder icon. This will open the "Buildstation/Remote"
menu
(Figure 3).

Figure 3. Buildstation menu

4. Move the mouse pointer and highlight the "Buildstation"
icon, then click to launch the Buildstation program.

(Continued from preceeding page...)
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Touring the Buildstation User Interface

Title Bar Menu Bar Toolbars Build Status

Build Job Project Tree Build Job Parameters Image

Build Job Options

Part Dimensions (CAD units) Status Bar

Figure 4. The Buildstation User Interface

Cuser guide 5.0 body1.p65 6/14/99, 10:39 AM13



14 Buildstation Control Software User's Guide

The Title Bar

Figure 5. The Title Bar

The Title Bar (Figure 5) is the strip located along the very top of the Build-
station window. It shows the version of Buildstation Software being used, and
the title of the current project.

The Main Menu Bar

Figure 6. The Main Menu Bar

The Main Menu Bar (Figure 6) is used to access the various functions in the
Buildstation Software. The Main Menu Bar has seven pull-down menu
groups. Clicking on any one of the items will open its pull-down menu
displaying more items to choose from. To perform that item's function, just
click on the item with the left mouse button. Some of the items in the pull-
down menus will open yet another submenu of items to choose from when
selected.

For complete information about each menu item, refer to Buildstation Main
Menu Functions later in this guide.

(Continued from preceeding page...)
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The Toolbars

Figure 7. The Toolbars

The Toolbars and associated buttons (Figure 7) are used to perform the
various functions in the Buildstation software. The buttons are shortcuts to
performing functions also available from the pull-down menus.

For complete information about the function of each toolbar and button, refer
to Buildstation Toolbar Functions later in this guide.

The Status Bar

Figure 8. The Status Bar

The Status Bar (Figure 8) is the strip along the bottom of the screen. It
displays such information as the date and time of day, elevator and sweeper
position, and resin temperature.

(Continues on the following page...)

Cuser guide 5.0 body1.p65 6/14/99, 10:39 AM15



16 Buildstation Control Software User's Guide

The Build Job Project frame

Figure 9. The Build Job Project frame

The Build Job Project frame (Figure 9) lists all projects on file and provides
the ability to group �builds� under a specific project name. The Build Job
Project frame is where you will select the job that you want to build.

For complete information about how to use the Build Job Project frame,
refer to Adding Projects and Jobs located under Essential Concepts: Steps
to Prepare the SLA and Start the Build later in this guide.

(Continued from preceeding page...)

Cuser guide 5.0 body1.p65 6/14/99, 10:39 AM16



Buildstation Control Software User's Guide 17

The Build Job Options frame

Figure 10. The Build Job Options frame

The Build Job Options frame (Figure 10) has seven ON/OFF toggle items
with check boxes. Each option is turned ON when a check mark appears in
the check box. The Build Job Options frame is used to turn ON or OFF
certain features prior to starting a build and diagnostic testing by a 3D Field
Service Representative.

NOTE!
To access the options other than "Auto Drain", refer to
Customize later in this guide. The options will be available
when checking the "Build Options" check box located in the
"Customize" dialog box.

For complete information about how to use the Build Job Options frame,
refer to Adjusting the Build Options located under Advanced Part Building
Techniques later in this guide.

(Continues on the following page...)
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The Part Dimensions frame

Figure 11. The Part Dimensions frame

The Part Dimensions frame and Restart position box (Figure 11) displays
the extents of the BFF file selected and the Restart position should a
stopped build need to be restarted.

For complete information about the Part Dimensions frame, refer to View-
ing the Part Dimensions (CAD units) located under Advanced Part Build-
ing Techniques later in this guide.

For complete information about Restarting a build using the Restart position,
refer to Pausing, Stopping and Restarting a Build located under Ad-
vanced Part Building Techniques later in this guide.

(Continued from preceeding page...)
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The Build Job Parameters frame

Figure 12. The Build Job Parameters frame

The Build Job Parameters frame (Figure 12) allows you to modify the
machine operation for building and contains the following boxes. The Draw
Speed Ceilings box, the Scale Factors box, the Z Build Range box, and
the Part Copies box.

For complete information about how to use the Build Job Parameters
frame, refer to Adjusting the Build Job Parameters located under
Advanced Part Building Techniques later in this guide.

(Continues on the following page...)
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The Build Status frame

Figure 13. The Build Status frame

The Build Status (Figure 13) frame shows specific information on the build
as it progresses.

For complete information about each item on the Build Status frame, refer
to Observing Build Progress located under Essential Concepts: Steps to
Prepare the SLA and Start the Build later in this guide.

The Image frame

Figure 14. The Image frame

The Image frame (Figure 14) is used to show build images in various views
of the object(s) being built during both build previews and actual builds.

For complete information about how to use the Image frame, refer to Image
frame located under Other Buildstation Features later in this guide.

(Continued from preceeding page...)
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System Setup

The information presented in this section contains procedures and pro-
cesses that should have already been completed either by your 3D Systems�
Field Engineer during the installation of your SLA system, or by your supervi-
sor as part of regular maintenance.

If your system is setup and ready to accept build jobs, you can skip this
section on System Setup and go directly to Essential Concepts: Steps to
Prepare the SLA and Start the Build.

Setting the Thermostat

The thermostat controls the resin vat heater and must be set to provide a
constant temperature and stable part building environment within the SLA
system. The resin type determines the desired temperature setting. Informa-
tion on the proper build temperature is included in the documentation pro-
vided with each shipment of resin.

NOTE!
Setting the Thermostat is usually a one time procedure
unless something has been changed on the SLA such as a
change of resin or after service work has been performed to
hardware or software.

To set the Thermostat:

1. From the Buildstation main window, click "Setup" on the
main menu bar to open the "Setup" pull-down menu
(Figure 15).

(Continues on the following page...)
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Figure 15. Setup Thermostat Pull Down Menu

2. Click "Thermostat..." from the "Setup" pull-down menu to
open the "Thermostat" dialog box (Figure 16).

Figure 16. Thermostat Dialog Box

(Continued from preceeding page...)
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3. Click the "Fahrenheit" check box if you wish to display the
thermostat setting in degrees Fahrenheit. To display the
thermostat setting in degrees Celsius, leave the box un-
checked.

4. Press the "Up" or "Down" buttons to reach the desired
thermostat setting.

5. Press the "OK" button to save the new setting.

NOTE!
If the SLA system has been off for an extended period of
time, the resin will not be at the proper temperature. Once the
system is powered on, it could take up to 36 hours to reach
the proper operating temperature. Do not attempt to build
parts before the temperature stabilizes.

Setting the Elevator Start Position

The elevator�s ideal build start position is when the build platform perforation
holes are half submerged into the resin when the resin is at a level condition.

NOTE!
Setting the "Elevator Start Position" is performed by the 3D
Systems� Field Engineer during installation and should not
need to be reset.

To set the Elevator Start Position:

1. Press the "Motion Control Dialog" button located on the
toolbars (Figure 17) to open the "Motion Control" dialog
box (Figure 19).

Figure 17. Motion Control dialog button

(Continues on the following page...)
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� OR �

2. From the Buildstation main window, click "Setup" on the
main menu bar to open the "Setup" pull-down menu
(Figure 18).

Figure 18. Setup Motion Control Pull Down Menu

3. Click "Motion Control..." from the "Setup" pull-down menu
to open the "Motion Control" dialog box (Figure 19).

For complete information on how to use Motion Control, refer to Motion
Control located under Other Buildstation Features later in this guide.

(Continued from preceeding page...)
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Figure 19. Motion Control Dialog Box

4. Click the "Elevator" radio button in the "Axis" section of
the "Motion Control" dialog box to select the "Elevator" as
the active component.

5. Press the "Home" button to send the elevator to its
"Home" position.

6. Press the "Go To Start button" to send the elevator to the
default or last saved start position.

7. Click the "Vat" radio button in the "Axis" section of the
"Motion Control" dialog box to select "Vat" as the active
component.

8. Press the "Level to 0.0### Gap" button to level the resin.
Add resin if needed.

(Continues on the following page...)
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9. Click the "Elevator" radio button in the "Axis" section of
the "Motion Control" dialog box to select the "Elevator" as
the active component.

10. Using the "Up" and "Down" buttons, position the platform
until its perforation holes are half submerged in the build
resin.

11. Repeat steps six through nine until the perforation holes
on the platform remain half submerged and the resin is
level.

12. Press the "Set Start Position" button to save the new
elevator start position.

13. Close the "Motion Control" dialog box by clicking the "X"
button in the upper right corner.

NOTE!
If you are running Windows NT 3.51, the procedure for
closing the dialog box may be different.

(Continued from preceeding page...)
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Choosing a Resin File

You must choose, or create, a resin file to match the characteristics of the
resin in your SLA system. Every SLA can use one or more resin types
depending on the parts being built and the type of recoater system in use.
The Buildstation software includes resin files to match the many CIBATOOL

resins offered by 3D Systems.

To Choose a Resin file:

1. From the Buildstation main window, click "Setup" on the
main menu bar to open the "Setup" pull-down menu
(Figure 20).

Figure 20. Setup Choose Resin Pull Down Menu

2. Click "Choose Resin�" from the "Setup" pull-down menu
to open the "Choose Resin File" dialog box (Figure 21).

(Continues on the following page...)
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Figure 21. Choose Resin File Dialog Box

3. The available resin file names appear in the window of the
dialog box. Figure 21 shows an example of the default
resin files encoded in the software, although your SLA
system may show different file names depending on the
model.

4. Click the appropriate resin file name that you desire to
build with.

5. Press the "Set as Default Resin" button if you wish to
make this resin file your default.

NOTE!
If you do not select a resin file name as your default, the
"Choose Resin File" dialog box will open when you begin the
next build.

6. Press the "OK" button to save your changes.

(Continued from preceeding page...)
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CAUTION!
Selecting an incorrect resin file will likely result in failed
builds, soft parts, and/or soft supports.

Adding a New Resin File

For many, the default resin files will be all they ever need to use for part
building. Some users create new resin files based on system measurements
made with the 3D Systems� AccuMax Peak Performance Toolkit or the
installation of a newly available resin. Since the default resin files cannot be
changed (or deleted), you can create a new resin file with a new name and
new values without risk to the default resin files.

To add a new resin file:

1. From the "Choose Resin File" dialog box, Press the "Add
New" button to open the "Add New Resin" dialog box
(Figure 22).

Figure 22. Add New Resin Dialog Box

2. Type the desired name for the new resin file in the text
box under "Resin Name".

(Continues on the following page...)
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3. Type in the desired "Dp", "Ec", and "Preferred Blade Gap"
values for the new resin file in the appropriate text boxes.

Be sure to use the correct unit of measurement.

4. When complete, press the "OK" button. The new resin file
appears in the window with the default resin files.

5. To select the newly added resin file for part building, use
the same method as selecting a default resin file described
in the previous section.

NOTE!
You can make changes to your custom resin file by entering
new "Dp", "Ec", and "Preferred Blade Gap" values in text
boxes in the "Choose Resin File" dialog box, then pressing
the "Save Changes" button

Deleting a Resin File

User-created resin files can be deleted. Default resin files cannot be deleted.

To delete a resin file:

1. From the "Choose Resin File" dialog box, click the file
name of the resin file you want to delete.

2. Press the "Delete" button.

3. Press "Yes" in the Delete Resin Type confirmation box
(Figure 23).

Figure 23. Delete Resin Type box

(Continued from preceeding page...)
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Selecting a Geometric Calibration File

During installation, and occasionally during system maintenance, your 3D
Systems Field Engineer will run a geometric calibration on your SLA system.
That calibration creates a file, stored in a file folder on the controller�s hard
disk, that is required for accurate part building.

A geometric calibration file name looks something like this:
991202145630.GEO. The file name represents the year, month, day, and
time of day that the calibration was performed.

To select a geometric calibration file:

1. From the Buildstation Main Window, click "Setup" on the
main menu bar to open the "Setup" pull-down menu
(Figure 24).

Figure 24. Setup Select Geometric Calibration File Menu

2. Click "Choose Geometric Calibration File�" from the
"Setup" pull-down menu to open the "Choose Geometric
Calibration File" window (Figure 25).

(Continues on the following page...)
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Figure 25. Select Geometric Calibration File Window

3. Navigate to the "Winsla5\Config" directory to locate the
desired file.

4. Click the desired file, then press the "Open" button to
select the desired file.

(Continued from preceeding page...)
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Essential Concepts: Steps to Prepare the SLA
and Start the Build

This section describes the necessary steps to deliver, select, and start a new
part build on your SLA system. It assumes the system is powered on and
ready to start building. If this is not the case, please review the information
on powering on and preparing the system in the SLA User's Hardware
Reference Manual.

The following sections list the essential steps necessary to begin building. As
an overview of the process, we list those steps here.

1. Installing a build platform

2. Adding and selecting a job

3. Adjusting the build parameters

4. Starting the build

5. Observing build progress

6. Completing the build

Installing a Build Platform

Before installing a build platform, make sure it is clean and free of polymer-
ized resin.

To install a build platform:

1. Press the "Motion Control Dialog" button located on the
toolbars (Figure 26) to open the "Motion Control" dialog
box (Figure 28).

Figure 26. Motion Control dialog button

(Continues on the following page...)
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� OR �

2. From the Buildstation main window, click "Setup" on the
main menu bar to open the "Setup" pull-down menu
(Figure 27).

Figure 27. Setup Motion Control Pull Down Menu

3. Click "Motion Control..." from the "Setup" pull-down menu
to open the "Motion Control" dialog box (Figure 28).

(Continued from preceeding page...)
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Figure 28. Motion Control Dialog

4. Ensure the "Elevator" radio button is checked, then press
the "Top" button to bring the elevator to its topmost
position.

5. Attach a clean platform to the platform supports on the
elevator.

NOTE!
Each SLA system has its own method of securing a platform
to the platform supports. See the SLA User's Hardware
Reference Manual for detailed instructions for your SLA.

6. Press the "Go To Start" button in the "Motion Control"
dialog box to send the platform to its start position.
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Adding Projects and Jobs

The next step is to add and select the job to build.

The Buildstation 5.0 software allows you to organize builds into Projects, and
Jobs within a project. A Project has one or more Jobs and each Job repre-
sents a single build file (BFF). You can create new Jobs within existing
Projects or create new Projects. The only limit to the number of Jobs in a
Project, or the number of Projects is the storage capacity of the hard disk in
the controller. Although the software gives Projects and Jobs default names
when they are created, you can rename them to whatever makes sense to
identify the contents of the Project or Job.

Figure 29 shows the Build Job Project frame and illustrates the project tree
with Jobs within Projects.

Figure 29. Build Job Project Frame

Notice in Figure 29 that there is one project named �Dept12_Projects,� and
that there are two jobs under that project, �Manifold_128B3� and
�CylHead_129A7.� Notice also that the Job �Manifold_128B3� is highlighted
and that the build file name, and path to the build file name, is displayed in
the file name window.

Now let�s say we want to add a new job. We could either add the new job to
the project �Dept12_Projects,� or we could add it to a new project.
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To add the new job to the existing project �Dept12_Projects�:

1. Click on any existing job in the project "Dept12_Projects."

2. Press the "Add button". The software creates a new job
named "New Job" in the project tree and simultaneously
opens the "OpenBff" window displaying the available BFF
files (Figure 30).

Figure 30. Adding New Job and Selecting New Build File

3. Click the desired build file and press the "Open" button.
This will add and assign the selected build file,
"WingSection_114J3.bff" to the newly created job
(Figure 31).

(Continues on the following page...)
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Figure 31. Build file Assigned to Newly Created Job

To add the job to a new project:

1. Click any existing Project.

2. Press the "Add" button. The software creates a new
project named "New Project", a new job named "New
Job1" in the new project, and simultaneously opens the
"OpenBff" window displaying the available BFF files
(Figure 32).

Figure 32. Build file Assigned to Newly Created Project

(Continued from preceeding page...)
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3. Click the desired build file and press the "Open" button.
This will add and assign the selected build file,
"WingSection_114J3.bff" to the newly created job in the
newly created project (Figure 32).

4. Press the "Save" button to save the new setting.

Starting the Build

Now that you have the build file transferred to the Buildstation computer, the
platform installed and ready, and the job selected:

1. Check that the "Auto Drain" box in the "Build Job Options"
frame contains a check mark indicating that this option is
selected and that all other boxes are empty. If not, click
them. Then,

2. Press the "Start Build" button on the Toolbar (Figure 33)
to start the build.

Figure 33. Start Build button

The computer initializes all of the SLA system�s hardware, including elevator
position, and adjusts the resin volume (add resin if needed, if not done
automatically). The laser comes on and the beam searches for, and locates
the Beam Profilers. The laser power adjusts for the build. The build begins
and the laser draws the first layer of the supports. It is a good idea to ob-
serve the first few layers should any problems arise.

NOTE!
A message box will appear if the resin temperature is out of
its recommended range. You have the option to continue
with the build anyway by pressing on the "OK" button or
cancelling the build by pressing on the "Cancel" button.

Cuser guide 5.0 body1.p65 6/14/99, 10:40 AM39



40 Buildstation Control Software User's Guide

Observing Build Progress

Once the build has started, the Build Status frame shows specific information
on the build as it progresses (Figure 34).

Figure 34. Build Status Frame

� Component: lists the STL file of the component part being drawn.

� Start Time: shows the time the system began the build.

� Est. End Time: is the software-calculated build completion time.

� End Time: is the actual build completion time. (This entry will be
blank until the build is completed.)

� On Layer: shows the current CAD layer building.

� Geo Cal File: reports the Geometric Calibration file in use.

� Action: shows the current machine operation.

� Laser Power: displays the last-read laser power.

� Border Speed: is the speed at which the most recent border vector
was drawn in inches per second.

� Hatch Speed: is the speed at which the most recent hatch vector
was drawn in inches per second.

� Fill Speed: is the speed at which the most recent fill vector was
drawn in inches per second.

� Resin File: displays the resin type being used for the build.

� Z Dip Distance: is the distance in inches that the elevator dips to
apply fresh resin to the top of the part or supports during the
recoating process before the laser draws the next layer.

� Pre Dip Delay: is the time in seconds between the time that the
laser finishes drawing until the elevator dips the part or supports into
the resin during the recoating process. This delay allows for further
curing of the just finished layer.
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� Z Level Wait: is the time that the recoating and leveling process is
complete to the beginning of drawing of the current layer. The Z Wait
time period allows for the resin to stabilize before the laser begins to
create the current layer.

� Number of Sweeps: is the number of the recoater blade sweeps
during the recoating process. The number of sweeps can be from 0
to 7 sweeps.

� Sweep Velocity: is the velocity in inches per second that the
recoater blade travels across the vat area.

Completing the Build

If the Auto Drain feature was checked before the build, the platform will be
positioned above the vat at the completion of the build. If the Auto Drain
feature was not checked, a message box will appear and ask you if you want
to "Drain part, Yes/No". To drain the part, press the Yes button.

If you do not want to drain the part at this time, press the No button. You can
drain the part at a later time by pressing the Platform to Top button, located
on the toolbars, to bring the platform to its topmost position. Wait approxi-
mately 15 minutes for the excess liquid resin to drain from the part.

Using proper safety procedures, open the chamber door and release the
platform from its hold down latch. Position the platform at a 45 degree angle
leaned against the back of the build chamber allowing the excess resin to
completely drain back into the vat. Use paper towels to keep the liquid resin
off the back panel. Refer to Appendix C. located in the SLA User's
Hardware Reference Manual for laser and chemical safety warnings.

When draining is finished, remove the platform from the build chamber,
leaving all other mechanisms in their current places.
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Advanced Part Building Techniques

Adjusting the Build Job Options

The Build Job Options frame (Figure 35) has seven ON/OFF toggle items
with check boxes. Each option is turned ON when a check mark appears in
the check box. The Build Job Options frame is used to turn ON or OFF
certain features during a build or preview build and diagnostic testing by 3D
Field Service Engineers.

NOTE!
To access the options other than "Auto Drain", refer to
Customize later in this guide. The options will be available
when checking the "Build Options" check box located in the
"Customize" dialog box.

Figure 35. Build Job Options Frame

The following steps describe what Build Job Options to select.

1. For normal part building operations, select "Auto Drain". A
check mark will appear in the check box.

2. Uncheck all other boxes for normal part building opera-
tions.
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Auto Drain-when checked, will raise the elevator to the upper limit upon
build completion. This allows resin to drain from the part and platform. Under
certain circumstances, you may choose to uncheck, or turn OFF the Auto
Drain, for example , fragile parts that are best raised with a slower elevator
velocity.

NOTE!
Only the "Auto Drain" option should be checked with a check
mark during normal part building operations.

Viewing the Part Dimensions (CAD units)

The Part Dimensions frame and Restart position box (Figure 36) displays
the extents of the BFF file selected and the Restart position should a
stopped build need to be restarted. See Pausing, Stopping and Restarting
a Build later in this guide.

Figure 36. Part Dimensions and Restart Position Box
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Adjusting the Build Job Parameters

The Build Job Parameters frame (Figure 37) allows you to modify the
machine operation for building and contains the following boxes. The Draw
Speed Ceilings box, the Scale Factors box, the Z Build Range box, and
the Part Copies box.

When a BFF file is selected by name, its Draw Speed Ceilings (in/sec),
Scale Factors, Z Build Range (CAD units), and Part Copies are displayed.

You can modify these by entering different values in the corresponding text
boxes.

Figure 37. Build Job Parameters Frame
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Adjusting Parameters

The text boxes in Build Job Parameters accept only numeric values.

Nominal values can be returned to all Build Job Parameters by pressing the
"Defaults" button of Figure 37.

Draw Speed Ceilings

The Draw Speed Ceilings box (Figure 38) shows the Draw Speed Ceiling
values for the laser beam at the vat, The recommended draw speed ceiling
values are set to appropriate default values for each machine type. This is
done to ensure part accuracy. By setting a draw speed ceiling, the laser will
be prevented from drawing faster than the speed shown in the text boxes.
Using faster draw speeds than the recommended values, may degrade part
accuracy. You can change the values if desired, but only within realistic
limits. Box B controls Border speeds while box H controls Hatching speeds.

Figure 38. Draw Speed Ceilings Box

(Continues on the following page...)
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Scale Factors

The Scale Factors box (Figure 39) allows you to enter the scale factors
necessary to compensate for part shrinkage. For valid values, refer to the
Build-Style Parameters document provided with the resin. You can also
determine these values by building Christmas-Tree parts using 3D Systems'
AccuMax Peak Performance Toolkit.

These parameters can also be provided to you by contacting 3D Plus+
Customer Support at 1-800-793-3669 (U.S. or Canada).

Scaling is used for accuracy; it is not a sizing function (i.e. half scale or 2x).
The default for X, Y and Z is set at 1.000. The range is 0.95 to 1.05.

Figure 39. Scale Factors Box

Z Build Range (CAD units)

The Z Build Range (CAD units) box (Figure 40) shows the �start� dimension
and the �stop� dimension of the selected part(s) to be built. These �start/stop�
CAD dimensions are used to build BFF segments.

The All radio button, when selected, will build complete parts over their entire
Z build range, while the Some radio button, when selected, will build seg-
ments of parts over some subrange specified by you. When the All button is
selected, no changes can be made in the text boxes.

Figure 40. Z Build Range (CAD units) Box

(Continued from preceeding page...)
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Part Copies

The Part Copies box (Figure 41) allows you to build multiple copies of the
same build file and also allows you to adjust the spacing and positioning of
the build files on the build platform.

The Copies: box displays the number of copies of the build file to be built.

Figure 41. Part Copies Box

The following steps describe how to build multiple copies of the same build
file and position the build files on the build platform.

1. Press the "Edit Copies..." button.

� Or �

Double-click in the Build Platform area.

This will open the "Part Position" dialog box (Figure 42)
which will allow you set the number of copies to be built
and to reposition the parts on the build platform.

(Continues on the following page...)
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Figure 42. Part Position Dialog Box

2. Press the "Number..." button.

This will open the "Number of Copies" dialog box
 (Figure 43).

(Continued from preceeding page...)
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Figure 43. Number of Copies Dialog Box

3. Type in the number of copies to be built, for example, "7"
or press the "Minimum" or "Maximum" buttons to select
the minimum or maximum number of copies that is al-
lowed by the software.

4. When finished, press the "OK" button to save.

Add

To add copies using the Add button:

1. Press the "Add" button.

NOTE!
To add copies in either "Square Layout" or "Prefer Rows",
select the desired option from the "Customize" dialog box.
Refer to Customize later in this guide for information.

Delete

To delete a copy using the Delete button:

1. Press the "Delete" button.

(Continues on the following page...)
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Spacing

The Spacing... button (Figure 42) allows you to manually set the spacing
distance between the build file copies on the platform.

The following steps describe how to set the spacing distance between the
parts on the platform.

1. Press the "Spacing..." button.

This will open the "Copy Spacing" dialog box
(Figure 44).

Figure 44. Copy Spacing Dialog Box

2. Type in the desired spacing distance in inches into the text
box or press on the "Minimum" or "Maximum" buttons to
select the minimum or maximum values that is allowed by
the software.

3. When finished, press the "OK" button to save.

(Continued from preceeding page...)
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Positioning

To place all the build file copies on the build platform, check the Auto-
Position check box with a check mark (Figure 42).

The following steps describe how to manually place the build file copies on
the build platform.

1. Select the copy by clicking on it with the right mouse
button (Figure 42).

2. While holding down the right mouse button, drag the
mouse. The copy will move as the mouse is moved.

3. When at the desired position, release the mouse button.

4. Press the "OK" button to save.

� Or �

1. Select the copy by clicking on it with the left mouse but-
ton.

2. Change the values in the X= and Y= position text boxes.
The copy will move.

3. Press the "OK" button to save.

Suppress Copy

The Suppress Copy button will allow you to stop the building of a build file
copy that may not be building properly without the need to stop the entire
build.

For complete information on how to suppress a copy, refer to Suppressing a
Copy later in this guide.
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Pausing, Stopping and Restarting a Build

Pausing a Build

Sometimes it may be necessary to Pause a build. For example, you may
need to remove bubbles from the resin, remove a piece of hardened resin
floating in the vat, suppress a copy (see Suppressing a Copy later in this
guide) or for other reasons.

The following steps describe how to Pause a build.

1. To Pause the build, press the "Pause Build" button on the
Toolbars (Figure 45).

Figure 45. Pause Build button

If there is an action in progress, the software will display
a box with a message which reads: "Action in progress,
waiting for task to end".

Once it safe to do so, the computer will pause the build
and display a box with the following message: "Build
Paused Successfully".

2. Press the "OK" button on the message box.

You can now safely open the Process Chamber door and
perform the needed task.

Restarting a Paused Build

The following steps describe how to Restart a Paused build.

1. Close the Process Chamber door(s).

2. Press the "Start Build" button on the Toolbars
(Figure 46).
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Figure 46. Start Build button

The build will resume where it left off.

Stopping a Build

Sometimes it may be necessary to stop a build. In the case of a recoater
blade stall, the software will probably stop the build to prevent damage to the
recoater system. In either case, it may be better to correct the problem and
start the build over from the beginning.

The following steps describe how to stop a build.

1. To stop a build, press the "Stop Build" button on the
Toolbars (Figure 47).

Figure 47. Stop Build button

The following message box will be displayed.

Figure 48. Stop build? Message Box

(Continues on the following page...)
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2. Press the "Yes" button.

NOTE!
The build continues until you press the "Yes" button.

Once it is safe to do so, the computer will stop the build
and display a box which reads: "Part [Job Name] build
stopped".

3. Press the "OK" button.

Restarting a Stopped Build

Some stopped builds can be restarted. For example, when building multiple
copies of a part. Sometimes not all of the parts have been damaged or failed
to build. After stopping the build you can remove damaged or failed parts and
pieces of parts from the vat and continue to build once the failed part or parts
have been suppressed (refer to Suppressing a Copy later in this guide).

Once the part has been suppressed, the build can be restarted by pressing
the Restart Build button on the Toolbars (Figure 49).

Figure 49. Restart Build button

(Continued from preceeding page...)
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NOTE!
If the elevator needs to be lowered to recover the recoater
blade to the front of the vat before restarting the build, follow
the procedures in the section on Recovering the Recoater
Blade to the front of the Vat later in this guide. The elevator
must then be repositioned back to the original position (last
known good layer position) prior to pressing the Restart
Build button.

To restart a part at a layer different from the shown "Restart Postion":

NOTE!
Buildstation can remain running, but it should not be
building a part.

1. To restart a stopped build when the last good layer of the
part is known, double-click the "BuildLog.txt" file located
in the "Winsla5\Output directory (Figure 50), to view the
BuildLog.txt file.

Figure 50. Winsla5\Output\BuildLog Window

(Continues on the following page...)

Cuser guide 5.0 body1.p65 6/14/99, 10:40 AM55



56 Buildstation Control Software User's Guide

2. Go to the last "Build.Start" record in the log file and write
down the job number (the job number is just to the left of
the BFF file name).

3. From Windows NT, select "Start button\Run..." to open the
"Run" dialog box.

4. Type "RegEdt32".

5. Press the "OK" button to open the "Registry Editor" main
window.

6. From the "Registry Editor" main window, select the
"HKEY_LOCAL_MACHINE_ on Local Machine" window from
the windows.

7. Select the "Software" file.

8. Select the "3D Systems" file.

9. Select the "Operations" file.

10. Double-click "Job Number".

11. Enter the job number that you wrote down in Step 2.

12. Press the "OK" button.

13. Double-click "Job Layer".

14. Enter the desired layer number.

15. Press the "OK" button.

16. Exit the "Registry Editor" window.

17. From Buildstation, select the job that you want to restart.

Make sure the restart layer is the desired start layer. If
not, select a different job then reselect the job that you
want to restart. If the restart layer does not change to the
layer set in the registry, you probably have entered the
wrong job number in the registry.

18. Press the "Restart Build" button (Figure 49 previously).

(Continued from preceeding page...)
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NOTE!
NEVER press the "Start Build" button when restarting a
build.

NOTE!
There is no guarantee that a stopped build can be restarted
and complete successfully.

Suppressing a Copy

Copies of the parts can be suppressed from the build at any time and are
displayed with an overdrawn Red X when suppressed (see Figure 42 under
Part Copies earlier in this guide). If you notice a problem developing, the
build can be paused or stopped and the problematic copy suppressed before
resuming the build to prevent further buildup of cured resin which might stall
the recoater blade.

The following steps describe how to suppress a part.

1. Select the part in the "Part Copies" dialog box that you
wish to suppress, with the left mouse button (Figure 42).

2. Press the "Suppress Copy" button.

The suppressed part will be marked with a red "X"
(Figure 42). The part will not build.

The "Unsuppress" button restores a copy to activity if used
before the build starts.

NOTE!
Unsuppress cannot restart a suppressed item once building
starts.

3. Press the "OK" button (Figure 42).
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Recovering the Recoater Blade to the front of the Vat

In the event of a recoater blade stall or blade crash, the recoater blade must
be moved to the front of the vat. This must be done in a manner which will
prevent damage to the recoater system.

The computer will stop a build once a recoater blade stall has occurred
regardless of the cause. Not all recoater blade crashes will stall the blade, it
depends on the severity of the blade crash. In the event of a recoater blade
crash that has not stalled the blade, the operator must stop the build manu-
ally (see Step 1 below).

Once the blade has been moved, the cause for the blade stall or blade crash
can be determined and corrected. The build can then be restarted from that
point, if possible, or restarted from the beginning.

The following steps describe how to recover the recoater blade to the front of
the vat in the event of a recoater blade stall or crash.

1. If the computer has stopped the build for any reason, go
to "Step 2". If a recoater blade crash is occurring, stop the
build immediately by pressing the "Stop Build" button on
the toolbars (Figure 47) (see Stopping a Build earlier in
this guide for complete details on stopping the build).

2. Once the computer indicates that the Build has been
stopped successfully, it is now safe to open the Process
Chamber door.

3. Cover the beam profilers with paper towels to prevent
resin from dripping on them.

4. Wearing the proper protective clothing and gloves, remove
all floating pieces of hardened resin, if any, from the vat
and recoater blade using a pair of large tweezers or simi-
lar tool.

5. If the path of the recoater blade to the front of the vat is
clear, you can move the recoater blade to the front by
pressing the "Recoater Forward" button on the toolbars.
Refer to Buildstation Toolbar Functions later in this guide
for complete details on the toolbar buttons.
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WARNING!
The path must be clear or damage to the recoater system
may occur. If the path is still blocked, go to Step 6. If the path
is clear and the recoater blade has been moved to the front,
go to Step 8.

6. If the path of the recoater blade is still blocked by dam-
aged parts that are still attached to the platform, you will
need to lower the elevator until all parts are well below
the recoater blade. To lower the elevator, use the "Motion
Control" dialog box to move the elevator down a specified
distance.

NOTE!
For a complete description of the "Motion Control" dialog
box, see Motion Control under Other Buildstation Features
later in this guide.

NOTE!
Lowering the elevator a specified distance, for example 2.00
inches, will be helpful in restarting a stopped build, because
you can raise the elevator that same distance just before
restarting the build. If you do not plan to restart the stopped
build, you can also lower the elevator by pressing the
"Elevator Down" button on the toolbar.

7. Repeat Step 5.

8. Once the recoater blade is at the front of the vat, it is now
safe to restart the build from that point (after reposition-
ing the elevator), if possible, or raise the elevator using
the "Elevator Up" button, removing the part and starting
the build from the beginning once the problem has been
corrected.



60 Buildstation Control Software User's Guide

Other Buildstation Features

The features and options listed below are also available from the Buildsta-
tion.

� Remote

� Motion Control

� Telephone

� SLA Performance Characteristics

� Field Service

� Adjust Resin Volume

� Level Resin

� Stir Resin

� Write ABRA Log

� Write Sensor Logs

� Customize

� Image frame

Remote

Remote is the utility for viewing the build status on a remote computer
running Windows NT which is networked to the SLA.

NOTE!
Before using Remote, the SLA must be named on the local
area network, usually at installation. The Remote software
must be copied to your remote computer.

There are 3 files which must be copied to your remote computer for the
Remote utility. These files can be located in the "WINSLA5" directory on
your SLA's computer. They are:

� StatCode.DLL

� MailSlot.DLL

� Remote.EXE
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These files should all be copied and placed into one directory located on
your remote computer.

The following steps describe how to access and use the Remote utility once
this has been done.

1. Double click "Remote.EXE" from the directory located on
your remote computer where you placed the above 3 files.

This will open the "Remote" dialog box (Figure 51).

Figure 51. Remote Dialog Box

2. Type in the following: "\\SLAname" inside the text box
under "Enter a machine Name" (where "SLAname" is the
name of the SLA to be accessed remotely).

3. Press the "OK" button.

The Remote [SLAname,x%] dialog box (Figure 52) displays essential
machine and build status information vital to monitoring SLA activity from a
remote computer. The title bar shows the machine name and build percent-
age complete.

(Continues on the following page...)



62 Buildstation Control Software User's Guide

Figure 52. Remote [SLAname] Dialog Box

NOTE!
To allow for your remote computer to monitor the SLA build,
check the "Enable Network Broadcasting" check box from
the "Customize" dialog box. Refer to Customize later in this
guide for information.

(Continued from preceeding page...)
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Motion Control

The Motion Control dialog boxes (Figures 55, 56, and 57) allows you to
manually move the Elevator, Vat and Recoater motors at various speeds and
distances. The Motion Control dialog boxes also allows you to monitor the
status of each of the axis positions, monitor the resin level, adjust the resin
level and set the build start position.

NOTE!
There are three different dialog boxes depending on which
axis is selected.

To access the Motion Control dialog boxes:

1. From the Buildstation main window, click "Setup" on the
main menu bar to open the "Setup" pull-down menu
 (Figure 53).

Figure 53. Setup Motion Control Pull Down Menu

(Continues on the following page...)
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(Continued from preceeding page...)

2. Click "Motion Control..." from the "Setup" pull-down menu
to open the "Motion Control" dialog box (Figure 55).

NOTE!
You can also open the "Motion Control" dialog boxes by
pressing the "Motion Control" dialog button located on the
toolbars (Figure 54).

Figure 54. Motion Control dialog button

To move an axis a desired distance:

1. Select the radio button next to its name.

The appropriate dialog box will appear.

2. Type in the desired values in the "Acceleration (Acc.)",
"Velocity (Vel.)", and "Distance (Dist.)" text boxes.

NOTE!
The Acceleration (Acc.), Velocity (Vel.) and Distance (Dist.) all
have default values that can be changed by you as needed as
long as you stay within the allowable ranges. Changing any
of the Motion Parameters will not affect part building. They
are only used for manually moving the motors at various
speeds and distances.
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NOTE!
When moving the "Elevator" and "Vat" down or the
"Recoater" forward, you must select the (+/- button) (plus/
minus button) next to the "Distance". text box or type in a
minus sign before the first numeral.

3. Press the "Move" button.

The movement will stop when the distance is reached or if
the axis reaches its limit.

If you need to stop the axis movement early, press the
"Stop" button or press the "Spacebar".

For making general axis movements:

1. Press and hold the "Up" or "Down" buttons for the "Eleva-
tor" and "Vat" or the "Forward" or "Backward" buttons for
the "Recoater".

To send any axis to its Home position:

1. Press the "Home" button

To send the elevator to its Top position:

1. Press the "Top" button

Motion Control also allows you to manually adjust the resin volume by
pressing the Adjust Resin button and to level the resin prior to part building
by pressing the Level to 0.0### Gap button (Figure 56).

NOTE!
When you exit "Motion Control", all Motion parameters return
to their default values.

(Continues on the following page...)
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(Continued from preceeding page...)

Figure 55. Motion Control Dialog Box with Elevator Selected
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Figure 56. Motion Control Dialog Box with Vat Selected

(Continues on the following page...)
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(Continued from preceeding page...)

Figure 57. Motion Control Dialog Box with Recoater Selected
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Telephone

The Telephone dialog box (Figure 60) allows you to enter numbers that will
allow you to be notified by telephone or pager when a build has either failed
or completed. You can program contact numbers for voice, pager or other
telephone notification (for example, a distinct number for either a �job com-
plete� or �job interrupt� occurrence). You can be telephoned or paged by the
SLA at one number or code if the build has failed and at another number or
code when the job has competed.

To access the Telephone dialog box:

1. From the Buildstation main window, click "Setup" on the
main menu bar to open the "Setup" pull-down menu
(Figure 58).

Figure 58. Setup Telephone Pull Down Menu

(Continues on the following page...)
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(Continued from preceeding page...)

2. Click "Telephone..." from the "Setup" pull-down menu to
open the "Telephone" dialog (Figure 60).

NOTE!
You can also open the "Telephone" dialog box by clicking
the "Telephone" button located on the toolbars (Figure 59).

Figure 59. Telephone button

To be notified In case of Failed Build:

1. Enter the telephone or pager numbers of all who will be
dialed in succession in the text boxes under In case of
Failed Build.

It may be necessary to insert commas for a 2-second
pause, for example, �9,1,334,443-2343�. The commas
permit the dial tone to return before dialing continues.

To enable the telephone number field:

1. Check the box next to "Send Notification to:"

To Test the dialing function:

1. Press the "Test" button.

To be notified Upon Successful Completion of Build:

1. Repeat the above steps.



Buildstation Control Software User's Guide 71

Figure 60. Telephone Dialog Box

Setting Telephone Paging for Buildstation 5.0 with Windows NT
4.0

The Telephone paging option in Buildstation 4.0 with Windows NT 4.0 uses
Remote Access Service (RAS) to dial out and Dial-Up Networking (DUN).

To set Remote Access Service:

1. Press the "Start" button.

2. Select Settings then select "Control Panel".

3. Select "Network" and choose the "Services" tab.

4. Highlight "Remote Access Service" and press the "Proper-
ties" button.

5. If no modem is shown, use "Add" to identify your modem.

If a different modem is shown, you must "Remove" it
before using "Add" to identify your modem.

(Continues on the following page...)
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(Continued from preceeding page...)

If the correct modem you are using is shown, press the
"Configure" button and select "Dial out only".

6. Press "OK" to close the Configure Port Usage window.

7. Press "Continue" to close Remote Access Setup window.

8. Press "Close" to exit Network window.

You will be prompted to shut down and restart computer.

9. Press "Yes".

To set Dial-Up Networking:

1. Select "My Computer".

2. Select "Dial-Up Networking".

If there are no previous entries, a dialog box will appear
stating �The phonebook is empty�, press OK. (If there are
previous entries, press the "New" button and proceed).

3. Type "WINSLA" to name the new phonebook entry then
press "Next".

4. Nothing in the Server window should be selected, press
"Next".

5. Enter a local phone or pager number then press "Next".

6. Press "Finish".

7. Test the RAS by pressing the "Dial" button.
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SLA Performance Characteristics

SLA Performance Characteristics dialog box (Figure 62) will make an
overall performance record output file of the latest performance characteris-
tics. This record can be used to determine estimated build times on future
builds by loading the latest performance characteristics into a job on a
desktop computer and running a build preview. This record can also be
useful in determining how well the machine is running overall, and will be
useful in determining when maintenance may be needed.

To access the SLA Performance Characteristics dialog box:

1. From the Buildstation main window, click "Setup" on the
main menu bar to open the "Setup" pull-down menu
(Figure 61).

Figure 61. Setup SLA Performance Characteristics Menu

2. Click "SLA Performance Characteristics..." from the
"Setup" pull-down menu to open the "SLA Performance
Characteristics" dialog box
(Figure 62).

(Continues on the following page...)
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(Continued from preceeding page...)

Figure 62. SLA Performance Characteristics Dialog Box

3. Press the "Save As..." button.

The "Save As" window opens that allows you to save and
rename the latest performance characteristics file.

4. Select the location where you wish to save the latest
performance characteristics file.

For example, you can save the file to your SLAs
"Winsla\Output" directory, a floppy disk or some where on
the network.

5. Press the "Save" button.
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6. From a desktop workstation running Buildstation, select
the build job that you wish to preview.

7. Open the "SLA Performance Characteristics" dialog box as
you did in steps 1 and 2.

8. Press the "Load..." button.

9. Select the location where you put the latest performance
characteristics output file.

10. Select the latest performance characteristics output file.

11. Press the "Open" button.

This will load the latest performance characteristics to the
job that you wish to preview and will give you a build time
estimation based on those characteristics.

NOTE!
The resin type must match.

Laser Power Limits

The Laser Power Limits Setup menu item is to be used only by qualified 3D
Systems Field Service Engineers.
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Field Service

The Field Service dialog box (Figure 64) is used to manually turn the laser
ON and OFF and to view the status of the laser.

To access the Field Service dialog box:

1. From the Buildstation main window, click "Setup" on the
main menu bar to open the "Setup" pull-down menu
(Figure 63).

Figure 63. Setup Field Service Pull Down Menu

2. Click "Field Service..." from the "Setup" pull-down menu to
open the "Field Service" dialog box (Figure 64).
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Figure 64. Field Service Dialog Box

To turn the laser ON:

1. Click the "Laser On" check box. A check mark will appear
in the box and the laser will come on.

NOTE!
This box is an "ON/OFF" toggle.

You can view the laser status in the upper scrollable
window.

To adjust the laser power (mW):

1. Press the "Up" or "Down" arrow buttons next to the
"Power" text box.

To turn the laser OFF:

1. Click the check mark in the "Laser On" check box.

You can view the Laser Status in the upper scrollable
window.

(Continues on the following page...)
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(Continued from preceeding page...)

Field Service... is also used by 3D Field Service Personnel to perform a
variety of laser beam calibrations and tests including Geometric Calibration
and locating the Beam Profilers with the laser beam.

Adjust Resin Volume

Adjust Resin Volume, when selected, will determine if resin needs to be
added or removed from the vat. You will be prompted to add or remove resin
if required. The SLA 350, SLA 3500, SLA 5000 and SLA 7000 will add resin
to the vat (refer to the SLA Hardware Reference Manual for additional
information). The SLA 500 requires you to manually add resin. When com-
pleted, the system levels the resin.

To adjust the resin volume:

1. From the Buildstation main window, click "Setup" on the
main menu bar to open the "Setup" pull-down menu
(Figure 65).

Figure 65. Setup Adjust Resin Volume Pull Down Menu
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2. Click "Adjust Resin Volume" from the "Setup" pull-down
menu to adjust the resin volume.

NOTE!
The following warning box (Figure 66) will appear if the
elevator build platform and platform support is not
submerged into the resin when attempting to adjust the resin
volume. If resin is added to the vat when the build platform is
too high, resin may be displaced when the build platform is
lowered, resulting in a resin spill. You have the option to
continue to adjust the resin volume by pressing the "OK"
button, or to cancel by pressing the "Cancel" button.

The recommended procedure is to position the elevator and
platform at the "Elevator Home" position or at the "Elevator
to Start Position" first and then adjust the resin volume. This
will prevent over filling the vat with resin.

Figure 66. Adding Resin Warning Box

NOTE!
You can also adjust the resin volume by pressing the "Adjust
Resin Volume" button located on the toolbars (Figure 67).

(Continues on the following page...)
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(Continued from preceeding page...)

Figure 67. Adjust Resin Volume button

Level Resin

Level Resin sets the resin to the appropriate system blade gap setting.

To level the resin:

1. From the Buildstation main window, click �Setup� on the
main menu bar to open the "Setup" pull-down menu
(Figure 68).

Figure 68. Setup Level Resin Pull Down Menu

2. Click "Level Resin" from the "Setup" pull-down menu to
level the resin.
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NOTE!
You can also level the resin by pressing the "Level Resin"
button located on the toolbars (Figure 69).

Figure 69. Level Resin button

Stir Resin

The Stir Resin dialog box (Figure 71) allows you to stir the resin by moving
the elevator up and down throughout the resin to allow the resin in the vat to
be a homogeneous mixture which will provide more uniform build character-
istics. Stirring may be particularly good for those who build large parts and
may add a lot of resin at a single time. Stirring may not be good for those
users whose vats are not well maintained. The recommended stir time is 20
minutes or more for all SLAs.

To access the Stir Resin dialog box:

1. From the Buildstation main window, click "Setup" on the
main menu bar to open the "Setup" pull-down menu
(Figure 70).

(Continues on the following page...)
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Figure 70. Setup Stir Resin Pull Down Menu

2. Click "Stir Resin..." from the "Setup" pull-down menu to
open the "Stir Resin" dialog box (Figure 71).

Figure 71. Stir Resin Dialog Box

To stir the resin:

1. Type in the desired time in the minutes text box.

2. Click the "Timer" box and place a check mark in it or the
resin will continue to be stirred until stopped by the user.

3. Press the "Stir" button.

(Continued from preceeding page...)
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Write ABRA Log

Write ABRA Log from the Setup pull-down menu (Figure 72) toggles the
function ON or OFF, with a check mark denoting the ON condition. The
ABRA Log is a diagnostic log for use by the user and 3D Field Service
Personnel that tracks and records laser draw speeds and laser power during
part building.

NOTE!
The "Write ABRA Log" files are placed in the "Winsla\Output"
directory.

To activate or deactivate the function:

1. From the Buildstation main window, click "Setup" on the
main menu bar to open the "Setup" pull-down menu
(Figure 72).

Figure 72. Setup Write ABRA Log Pull Down Menu

2. Click "Write ABRA Log" from the "Setup" pull-down menu.
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Write Sensor Logs

Write Sensor Logs from the Setup pull-down menu (Figure 73) toggles the
function ON or OFF, with a check mark denoting the ON condition. The Write
Sensor Logs is a diagnostic log for use by the user and 3D Field Service
Personnel that tracks laser beam positioning and power for each sensor.

NOTE!
The "Write Sensor Logs" files are placed in the
"Winsla\Output" directory.

1. From the Buildstation main window, click "Setup" on the
main menu bar to open the "Setup" pull-down menu
(Figure 73).

Figure 73. Setup Write Sensor Logs Pull Down Menu

2. Click "Write Sensor Logs" from the "Setup" pull-down
menu.
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Customize

The Customize dialog box (Figure 75) is used to define specific methods for
positioning parts on the platform for a build or preview, to see whether new
jobs inherit parameters of previous jobs, to Enable Network Broadcasting
and to allow Advanced Build options.

To access the Customize dialog box:

1. From the Buildstation main window, click "Setup" on the
main menu bar to open the "Setup" pull-down menu
(Figure 74).

Figure 74. Setup Customize Pull Down Menu

2. Click "Customize..." from the "Setup" pull-down menu.

(Continues on the following page...)
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Figure 75. Customize Dialog Box

Select the following options as desired.

Part Position

Strict part positioning, when checked, allows nesting of parts whose
extents only allow a limited number of copies on the platform.

Automatic Copy Placement

No auto positioning of parts under blade shadow when checked, pre-
vents parts from being placed in the blade shadow.

Prefer Rows radio button arranges copies in a straight line (row) until the
edge of the build area is reached. When more copies are requested than will
fit on a line, a second line is started. This is to take the greatest advantage of
SmartSweep.

(Continued from preceeding page...)
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Square Layout radio button arranges copies toward the center of the
platform in an approximately square area.

On New Jobs

Duplicate all Build Job Parameters when checked, causes new jobs to
inherit the parameters and parts' placement of the previous build. The
included note says: "If this option is not selected, number of copies,
separation and restartz will be set to their default values. Parts will
always be repositioned."

Network

Enable Network Broadcasting when checked, permits a remote computer
to monitor the build.

Build Options

Build Options when checked, allows you access to all of the build job option
check boxes located in the Build Job Options frame. The included note
says: "All Advanced Build Options are disabled if this option is not
selected."

The Advanced Build Options are not designed for use in a production
environment.
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Image frame

You can set up the Image frame (Figure 76) to show build images in various
views of the object(s) being built during both build previews and actual
builds. With the right mouse button, click anywhere in the Image frame to
see the "Zoom/Setup" menu (Figure 77).

Figure 76. Image Frame Showing Views

Sizable Build Status and Image frames

The size of the frames for Build Status and Image may be changed to suit
your preference at any time during setup or build procedures using two
different methods:

To Resize a frame:

Maximize the Build Status and Image frames by �double-clicking� inside the
frame. To return to normal, �double-click� again. Or, place the mouse pointer
on the left-edge (or top-edge) of the Image frame. When the mouse pointer
changes into two lines with action arrows, click and drag the mouse to resize
the frame.
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Scroll Bars

There are Scroll Bars located along the bottom of the Build Status frame and
along the bottom of the Image frame. There is also a Scroll Bar along the
right side of the Image frame. They can be identified by their little arrows at
each end. Clicking on the little scroll arrows will cause the frames to scroll
either horizontally or vertically to view the sections of the frames that are
hidden in the Buildstation window.

Viewing the Image

The Zoom in and Zoom out menu selections (Figure 77) magnify or reduce
the �build part(s)� Image size. Note that zooming action depends on where
you click with the right mouse button. If you click on the view, only that view
is zoomed. If you click away from all views but in the Image frame, all views
will be zoomed.

Figure 77. Image Setup and Zoom Window

(Continues on the following page...)
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(Continued from preceeding page...)

Selecting Setup from the menu (Figure 77) opens the View Setup dialog
box (Figure 78 shows default settings).

Figure 78. View Setup Dialog Box

You can select views from the View Setup dialog box (Figure 78). These
selections can be made either before or during a build  or preview. To
display, the views must be both Enabled and Visible.

Maximum Bitmap Size

View Setup allows you to view the bitmap in various axes and sizes, offering
choices in integers from 30 to 1000. The choices must be selected before a
build or preview is started.

Enabled

Selecting this makes the software track particular views throughout the build.

Visible

This selection displays the view in the Image area.
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Title

This displays the view title and allows you to easily differentiate between
Top / Layer and Side X / Side Y views.

Ver. Dim

This displays the vertical, or Z-axis, dimension of the object(s) being built in
the view selected.

Hor. Dim

This displays the horizontal, or X and Y-axes, dimensions of the object(s)
being built in the view.

Border

This displays the border vectors of the object(s) being built in the view.

Fill

This displays the fill vectors of the object(s) being built in the view.

Hatch

This displays the hatch vectors of the object(s) being built in the view.

Progress

This displays an overall Z-axis dimension similar to Ver. Dim on the Side X
View and Side Y Views, but also indicates the build progress layer by layer
with an asterisk on the dimension line.

NOTE!
Displaying views can cause a build to slow down. For the
fastest possible build times, it is recommended that these
views be disabled when not in use, e.g. when the operator is
not at the machine. The views can be set up, and then
disabled when not being used.

(Continues on the following page...)
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(Continued from preceeding page...)

To resize all views, click in the Image area away from the views with the right
mouse button again and select Zoom in or Zoom out.

To apply resizing options to a single view only, click the right mouse button
directly on an image. The floating menu appears with Hide, which makes a
single view disappear (recover by pressing the OK button in the View Setup
dialog box).

Buildstation Toolbar Functions

Figure 79. The Toolbars

The Toolbars (Figure 79) have several control buttons divided among five
toolbars. Each toolbar is moveable and lockable so that a user can position
them anywhere on the screen. The machine functions are activated by a
single click of the left mouse button on the associated Toolbar button. Refer
to the section View (Toolbars) later in this guide on how to access the Tool
bars.
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Build Toolbar

The "Build" Toolbar buttons are:

Start Build, Pause Build, Stop Build, Restart Build and Preview Build.

NOTE!
The "Start" and "Restart" buttons are only enabled if both
Process Chamber doors are closed and all panels securely in
place. An "X" over the icon indicates open interlocks.

� The Start Build button begins a build or resumes the build after a
paused build. Refer to the section Starting the Build located under
Essential Concepts: Steps to Prepare and Start the Build described
earlier in this guide for complete details.

� The Pause Build button pauses the build. Refer to section Pausing,
Stopping and Restarting a Build located under Advanced Part
Building Techniques described earlier in this guide for complete
details.

� The Stop Build button stops a build. Refer to section Pausing,
Stopping and Restarting a Build located under Advanced Part
Building Techniques described earlier in this guide for complete
details.

� The Restart Build button restarts stopped builds. There is no
guarantee that a restarted build will complete successfully. Refer to
section Pausing, Stopping and Restarting a Build located under
Advanced Part Building Techniques described earlier in this guide for
complete details.

� The Preview Build button runs a preview of the build. This shows a
layer by layer representation of the build without invoking hardware
functions. The preview is displayed in the Image frame section of the
build window.

(Continues on the following page...)
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(Continued from preceeding page...)

Main Motion Toolbar

The "Main Motion" Toolbar buttons are:

Recoater Forward, Recoater Backward, Elevator Up, Elevator Down,
Elevator Home, Elevator to Start Position, Platform to Top, Adjust Resin
Volume, and Level Resin.

The motion controls for the Recoater and Elevator buttons (the first four of
this group) are �momentary contact� only. This means that motion is
activated by pointing to the icon and holding down the left mouse button;
motion ceases at mouse button release.

NOTE!
The "Elevator" and "Recoater" buttons will only be enabled
when it is safe to move them to prevent a collision between
the Elevator and Recoater. An "X" over the icon indicates
open interlocks.

� The Recoater Forward button moves the recoater blade forward.

� The Recoater Backward button moves the recoater blade
backward.

� The Elevator Up button moves the elevator up.

� The Elevator Down button moves the elevator down.

� The Elevator Home button moves the elevator to its home position.

� The Elevator to Start Position button repositions the elevator to the
last saved elevator start position.

� The Platform to Top button moves the elevator to its top position.
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� The Adjust Resin Volume button allows you to adjust the resin
volume and prompts you to add or remove resin in the SLA if
required. Refer to the section Adjust Resin Volume located under
Other Buildstation Features described earlier in this guide for
complete details.

� The Level Resin button sets the resin to the appropriate system
blade gap level. Refer to the section Level Resin located under
Other Buildstation Features described earlier in this guide for
complete details.

Other Motion Toolbar

The "Other Motion" Toolbar buttons are:

Vat Up, Vat Down, Vat Home, and Recoater Home.

� The Vat Up button moves the vat up.

� The Vat Down button moves the vat down.

� The Vat Home button moves the vat to its home position which is
just below the vat�s upper limit.

� The Recoater Home button moves the recoater blade to its home
position which is at the recoater blade�s front limit switch (front of the
vat).

NOTE!
An "X" over the icon indicates open interlocks.

(Continues on the following page...)
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(Continued from preceeding page...)

Telephone Toolbar

The "Telephone Setup" Toolbar button is:

Telephone Setup button

� The Telephone Setup button opens the Telephone dialog box which
allows you to enter telephone or pager numbers that allows you to be
notified by telephone or pager when a build has either failed or
completed. Refer to the section Telephone located under Other
Buildstation Features described earlier in this guide for complete
details.

Motion Control Toolbar

The "Motion Control Dialog" Toolbar button is:

Motion Control Dialog button

� The Motion Control Dialog button opens the Motion Control
dialog box. Refer to the section Motion Control located under Other
Buildstation Features described earlier in this guide for complete
details.
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Buildstation Main Menu Functions

File

Opens the File pull-down menu.

Figure 80. The File pull-down menu

New Build Window

Selecting this option opens a new build window. Only one part, or set of
parts, can built at a time, but this will allow you to preview other builds at the
same time a current build is running on the SLA.

Close Build Window

Selecting this option closes the active build window. For example, after
running a preview, you can close that window to view the current job running
on the SLA.

Print Build Settings

Allows you to print the window if the controller is linked to a networked
printer.

Print Preview

Displays a preview of the Build Settings that would be printed by Print Build
Settings. If there is no printer attached locally or via the network, a No
Printer dialog box appears.

(Continues on the following page...)
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Print Setup

Allows you to set printer options. If no printer is attached locally or via the
network, a No Printer dialog box appears.

Exit

Shuts down the Buildstation Software.

Edit

Opens the Edit pull-down menu.

Figure 81. The Edit pull-down menu

Undo

Reverses a prior action.

Cut

Removes whatever is highlighted from a line of text. The removed text goes
into the Windows NT�s clipboard and can be pasted into another application.

Copy

Copies highlighted text to the clipboard.

Paste

Places clipboard text at the cursor point.

(Continued from preceeding page...)
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View (Toolbars)

Opens the View pull-down menu.

Figure 82. The View Toolbars pull-down menu

Toolbars

Displays a submenu, which allows you to display or hide the 3D Systems
Logo, Build, Motion Control Dialog, Main Motion, Other Motion, and
Telephone toolbars and buttons. A check mark on the menu item indicates
that the item is visible on the screen. Clicking on any of the menu items will
display or remove the check mark and corresponding toolbar, logo or
button.

Logo

Allows you to display or hide the 3D Logo on the toolbar.

Build

Allows you to display or hide the Build toolbar buttons.

Motion Control Dialog

Allows you to display or hide the Motion Control Dialog toolbar button.

Main Motion

Allows you to display or hide the Main Motion toolbar buttons.

(Continues on the following page...)
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(Continued from preceeding page...)

Other Motion

Allows you to display or hide the Other Motion toolbar buttons.

Telephone

Allows you to display or hide the Telephone Setup toolbar button.

View (Status Bar)

Opens the View pull-down menu.

Figure 83. The View Status Bar pull-down menu

Status Bar

Allows you to display or hide the Status Bar. A check mark on the menu
indicates that the Status Bar is visible at the bottom of the screen.
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Build

Opens the Build pull-down menu.

Figure 84. The Build pull-down menu

NOTE!
Many of the following menu items perform the same function
as the buttons on the "Build" Toolbar.

New Build Window

Selecting this option opens a new build window. Only one part, or set of
parts, can built at a time, but this will allow you to preview other builds at the
same time a current build is running on the SLA.

Build Part

Begins a build or resumes the build after a paused build. Refer to the section
Starting the Build located under Essential Concepts: Steps to Prepare and
Start the Build described earlier in this guide for complete details.

Delayed Build

Opens the Delayed Build dialog box which allows you to enter and confirm a
desired date and time in which you want a build to start.

(Continues on the following page...)
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(Continued from preceeding page...)

Figure 85. Delayed Build Dialog Box

Pause Build

Pauses the build. Refer to section Pausing, Stopping and Restarting a
Build located under Advanced Part Building Techniques described earlier in
this guide for complete details.

Stop Build

Stops a build. Refer to section Pausing, Stopping and Restarting a Build
located under Advanced Part Building Techniques described earlier in this
guide for complete details.

Restart Build

Restarts stopped builds. There is no guarantee that a restarted build will
complete successfully. Refer to section Pausing, Stopping and Restarting
a Build located under Advanced Part Building Techniques described earlier
in this guide for complete details.

Preview Part

Runs a preview of the build. This shows a layer by layer representation of the
build without invoking hardware functions. The preview is displayed in the
Image frame section of the build window.
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Setup

Opens the Setup pull-down menu.

NOTE!
Each of the following menu items are described in detail
earlier in this Guide.

Figure 86. The Setup pull-down menu

Motion Control�

Refer to the section Motion Control located under Other Buildstation
Features described earlier in this guide for complete details.

Choose Resin

Refer to the section Choosing a Resin File located under System Setup
described earlier in this guide for complete details.

(Continues on the following page...)
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(Continued from preceeding page...)

Choose Geometric Calibration File

Refer to the section Selecting a Geometric Calibration File located under
System Setup described earlier in this guide for complete details.

Thermostat

Refer to the section Setting the Thermostat located under System Setup
described earlier in this guide for complete details.

Go to Elevator Start Position

Sends the elevator to its last saved start position.

Adjust Resin Volume

Refer to the section Adjust Resin Volume located under Other Buildstation
Features described earlier in this guide for complete details.

Level resin

Refer to the section Level Resin located under Other Buildstation Features
described earlier in this guide for complete details.

Stir Resin�

Refer to the section Stir Resin located under Other Buildstation Features
described earlier in this guide for complete details.

Telephone�

Refer to the section Telephone located under Other Buildstation Features
described earlier in this guide for complete details.

SLA Performance Characteristics�

Refer to the section SLA Performance Characteristics located under Other
Buildstation Features described earlier in this guide for complete details.

Laser Power Limits...

Laser Power Limits is a utility to be used only by 3D Systems Field Service
Engineers.
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Field Service...

Refer to the section Field Service located under Other Buildstation Features
described earlier in this guide for complete details.

Write ABRA log

Refer to the section Write ABRA Log located under Other Buildstation
Features described earlier in this guide for complete details.

Write Sensor Logs

Refer to the section Write Sensor Logs located under Other Buildstation
Features described earlier in this guide for complete details.

Customize�

Refer to the section Customize located under Other Buildstation Features
described earlier in this guide for complete details.
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Window

Opens the Window pull-down menu.

Figure 87. The Window pull-down menu

Cascade

Cascade allows you to display all the open windows in cascading layers
(Figure 88); only the front window is active.

Figure 88. Four cascading open Build windows
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Tile

Tile arranges all windows on the screen so that there are no overlaps
(Figure 89).

Figure 89. Four tiled open Build windows

Arrange Icons

Arrange Icons in WinSLA.
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Help

Opens the Help pull-down menu.

Figure 90. The Help pull-down menu

About WinSLA...

About WinSLA... opens the About Buildstation dialog box (Figure 91) which
contains version number Buildstation 5.0, Build ID: date and time, and
Machine Type: SLA xxx. This information identifies the specifics of software
creation and installation.

Figure 91. About Buildstation Dialog Box
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Appendix A.

Using the Windows NT Operating System

Windows NT (NT) is a 32-bit operating system developed by Microsoft Corp.
Being a 32 bit system means NT offers several advantages. Because of
improved methods of data storage and use, more programs offering greater
productivity will be developed for 32-bit systems than for the old 8 and 16-bit
systems. NT is easier to use and permits more than one person to work on
the same computer at the same time if they are joined together by a network.
It also can run several jobs on one computer at the same time.

Start Up

When the computer is turned on its software prepares the system for opera-
tion. This is called initialization. The screen will display a message that
allows the user to launch either the DOS or the NT software operating
system. The system will automatically launch into the NT operating system
unless the DOS operating system is selected by the user during initialization.

The Basics

The Mouse

A computer mouse is a pointing device that was first developed in the
1950�s. Inside a typical mouse there are three rollers that contact the sides of
a roller ball. As the mouse is moved, the different rollers report the amount of
ball movement to the computer�s processor.

The Basic Mouse Operations

Using NT requires learning these basic mouse operations: moving the cursor
and pointer, clicking, double-clicking, click and drag and highlighting. Usually,
the user will click the left mouse button. Instructions will specify those cases
where the right button is to be used.
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The cursor is an image that appears on the monitor screen and is always
blinking and will move as the mouse is moved. Its primary function is to
show the user where text or numbers will typed in from the keyboard.
Wherever the cursor is, that is where any text or numbers typed in from the
keyboard will appear. Where the cursor is positioned depends on the relative
position and movement of the mouse. The computer software is pro-
grammed to interpret mouse movements and to display its interpretation on
the screen. The software is designed to be straightforward. If the mouse is
moved to the right, the cursor on the screen moves in a similar fashion. The
speed of movement can be set on the computer�s control panel.

The pointer is similar to the cursor but does not blink. It will usually look like
an arrow but can take other shapes as well depending where it is being
placed on a window. It will sometimes look like an hour glass when the
computer is doing something and telling you to wait. Its primary function is
for selecting and activating menu items and buttons in the windows. The
pointer will turn into a cursor when placed inside a text box so that text or
numbers can be typed.

To Click the mouse means to push on one of the buttons, usually the left.
Often when the cursor or pointer is located on an item that appears on the
screen, clicking sends a signal to the computer to perform some action
related to that item. This is the most common mouse operation.

Double clicking means to click the mouse button twice in rapid succession.
The speed at which the user prefers to double click can be set in the control
panel.

Click and Drag means using the mouse to place the pointer on a specific
place on an object you wish to move then press and hold down the mouse
button and drag the mouse. After dragging the mouse, release the button.
The object on the screen will move as the mouse is moved.

Highlighting means to select text. This can be done by placing the mouse
cursor on the text to be selected and clicking and dragging across the text.
Sometimes text can be selected by clicking or double clicking on it.

The Keyboard

The keyboard is still an important tool for communicating with the computer
by typing text, entering numbers, using the up, down, right, and left arrows
and using the Enter, Control, Spacebar, Backspace, Delete and Escape
keys.
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Keyboard Equivalents

NOTE!
The keyboard equivalents listed below are mainly geared
toward the Buildstation 5.0 software. Although the keyboard
commands will work the same way for Windows NT in
general, the Menu items may be different. For information
about Windows NT 4.0 in general, refer the Windows NT 4.0
manual that comes with your software.

All of the items listed on the Menu Bar and their pull-down menus can be
activated directly from the keyboard without using the mouse. For example,
on the Menu Bar the keyboard equivalent of Setup is, to hold down the <alt>
key and press the <S> key at the same time. This will then display the Setup
pull-down menu. Notice that the �S� in Setup is underlined.

All of the items from the Menu Bar can be activated by holding down the
<alt> key and then pressing the underlined letter at the same time. To exit
any or all menus, just press the <alt> key. Once a pull-down menu is show-
ing, you can activate an item by moving the highlight bar to the desired item
using the Up or Down arrow keys then pressing the <Enter> key.

Some items from the pull-down menus have speed keys or shortcut keys
that allow you to activate an item without the menu showing. For example,
from the File pull-down menu, you can open a New Build Window by holding
down the <Ctrl> key and pressing the <N> key at the same time. If any item
has a speed key, in the pull-down menus, it will be listed just to the right of
the item such as, New Build Window    Ctrl+N.

Notice that the �N� in New Build Window is underlined, this indicates that by
pressing the <N> key while that menu is showing, will also activate that
function instead of clicking on it with the mouse or moving the highlight bar to
it with the arrow keys and pressing <Enter>. All of the underlined letters in
the pull-down menus will work this way. In other words, the user has several
options available to perform the same functions.

To move from one menu on to another on the Menu Bar, press the Right or
Left arrow keys.
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Icons

Icons are the little images or pictures that appear on the monitor screen
symbolizing programs, directories, etc. Placing the mouse pointer on them
and clicking or double-clicking will open that icons�s program, directory or
file.

Windows

Windows are rectangular boxes that appear on the monitor to provide or
receive information. Often a user will use a window to enter data, make
menu selections or click on something the window is displaying.

Many windows can be resized. When the mouse pointer is placed on the
corner of a resizeable window, it changes in appearance into a two headed
arrow. By holding down the left mouse button and dragging the mouse with
the two headed arrow on the window�s corner, the user can make the window
change size (larger or smaller).

Windows have control buttons in their upper right corner. The buttons in the
upper right corner are used to reduce the window to an icon on the task bar
or to minimize or maximize the window or to close the window.

To move a window around on the screen that may be hiding something
behind it that you want to look at, just place the mouse pointer on the Title
Bar, hold down the left mouse button and drag the mouse. As the mouse is
moved, the window will move with it. When the window is at its new location,
release the mouse button.

Menus and Pull-Down Menus

A menu is a selection of features that a user may access. A pull-down menu
is a hidden menu that appears, usually after selecting features from the
Menu Bar such as, File, Edit, etc., that opens to reveal its additional options/
features when the user clicks the mouse on it.

To choose a menu item, the user places the mouse pointer on the desired
selection and clicks the left mouse button.
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Logging On and Off

When NT is launched, a log on screen appears. The user logs on by press-
ing the Control, Alt and Delete keys simultaneously. The system will then
bring up a password screen. This security feature allows access only to
registered users. Without a correct password, the system software will not
respond. If the user types a valid password, the system then goes to the
Program Manager window.

Launching Software

To launch software in NT, double click on the icon or file name of the pro-
gram desired.

Introducing Windows NT

Clicking on this icon will show a brief tour of some features of NT. Some of
the subjects covered include Logging On, Networking, Sharing Files, User
Accounts and Using Help.

Dialog Boxes

Many of the pull-down menu items (the ones followed by three dots... or
ellipsis) have dialog boxes for the user to enter information when those items
are selected. Most dialog boxes allow the user to enter text and/or numbers
into text boxes as needed. To enter data into a text box, you must highlight
the old data by placing the cursor/pointer into the text box and double-
clicking the left mouse button then begin typing.

Dialog boxes may also contain one or more check boxes that allow the user
to select or deselect certain features as needed by placing a check mark in
the check box. One or more of the check boxes can be checked as needed.
Some dialog boxes contain little round check buttons. These buttons are for
�either/or� functions The software will only allow you to choose just one of
these buttons that are grouped together. To select or deselect, place the
mouse pointer in the check box or button and click the left mouse button.

Many dialog boxes contain �push� buttons that allow the user to activate
certain features by placing the mouse pointer on that button and �pushing�
it by clicking the left mouse button. Two of the most common buttons are the
�OK� and �CANCEL� buttons. The �OK� button is mainly used to save any
changes just made in the dialog box, while the �CANCEL� button will allow
you to �exit� the dialog box without changing any data or settings.
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To move a dialog box around on the screen that may be hiding something
behind it that you want to look at, just place the mouse pointer on the Title
Bar, hold down the left mouse button and drag the mouse. As the mouse is
moved, the dialog box will move with it. When the dialog box is at its new
location, release the mouse button.

Active Window

When the Window menu is pulled down, all open build windows will be listed
at the bottom of the menu with a number corresponding to the order in which
they were opened. There will be a checkmark beside the name of the active
window. Only one window can be active at a time. The active window will
display a colored Title Bar at the top. The software controls will work in the
active window only.
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Appendix B.

Error Messages

The following is an alphabetical listing of some of the error messages that
may appear, along with an explanation of what they mean and what action to
take. There are however, other error messages that can appear but are rare
and are beyond the scope of this document. Should they occur, call 3D Plus+
at the telephone number below.

For further information call 3D Plus+ Customer Support at 1-800-793-3669
(U. S. or Canada), or call your local 3D Systems' Representative.

Error Message: Beam not found while profiling

Cause: Could not find laser beam.

Action: Make sure door is not ajar. Check laser power.
Make sure laser can turn on. If problem persists,
notify 3D Plus+ and request your Field Engineer.

Error Message: Cannot find the GEO file

Cause: GEO file does not exist.

Action: Check the existence of the GEO file from the Setup
pull-down menu under Choose Geometric
Calibration File.

Error Message: Cannot move the elevator, recoater is not at
a safe position

Cause: Recoater is not at home position while attempting to
move elevator.

Action: Move the recoater to its home position.
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Error Message: Cannot move the recoater: Elevator is in an
unsafe position

Cause: Interlocked by safe sweep zone.

Action: Lower the elevator until it is not at home.

Error Message: Cannot open AXIS kernel device driver

Cause: Possible incorrect software installation.

Action: Reboot. If problem persists, reinstall Buildstation
software.

Error Message: Cannot open DSP kernel device driver

Cause: Possible incorrect software installation.

Action: Reboot. If problem persists, reinstall Buildstation
software.

Error Message: Cannot open IO3D kernel device driver

Cause: Possible incorrect software installation.

Action: Reboot. If problem persists, reinstall Buildstation
software.

Error Message: Could not open drawing servo parameters
file �params.dat�

Cause The servo parameters file �params.dat� should be in
the directory in which �Buildstation� is installed.

Action: Reinstall Buildstation software. If problem persists,
notify 3D Plus+ and request your Field Engineer.

Error Message: Disk IO error while profiling

Cause: Hard disk may be full.

Action: Delete unnecessary files. If problem persists, notify
3D Plus+ and request your Field Engineer.
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Error Message: DSP Command timed out

Cause: Potential hardware problem.

Action: Reboot, notify 3D Plus+ and request your Field
Engineer.

Error Message: DSP firmware error

Cause: Potential hardware problem.

Action: Reboot, notify 3D Plus+ and request your Field
Engineer.

Error Message: Elevator acceleration or velocity out of
range.

Cause: Bad instructions in BFF file.

Action: Reprepare file.

Error Message: Elevator hit bottom during dip.

Cause: Part height beyond machine capacity.

Action: Check maximum part height. Limit switches may
need adjustment: Notify 3D Plus+ and request your
Field Engineer.

Error Message: Elevator hit bottom without finding home

Cause: Potential hardware problem; no home switch
detected.

Action: Reboot, notify 3D Plus+ and request your Field
Engineer.

Error Message: Error acquiring beam profiler

Cause: System was not able to acquire profiler information.

Action: Make sure door is not ajar.  Check laser power. If
problem persists, notify 3D Plus+ and request your
Field Engineer.
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Error Message: Error converting laser argument data

Cause: Potential hardware problem.

Action: Reboot, notify 3D Plus+ and request your Field
Engineer.

Error Message: Error discerning pinhole powers

Cause: Profiling did not complete properly.

Action: Make sure door is not ajar. Check laser power. If
problem persists, notify 3D Plus+ and request your
Field Engineer.

Error Message: Error finding half mil pinhole

Cause: Profiling did not complete properly.

Action: Make sure door is not ajar. Check laser power. If
problem persists, notify 3D Plus+ and request your
Field Engineer.

Error Message: Error finding one mil pinhole

Cause: Profiling did not complete properly.

Action: Make sure door is not ajar. Check laser power. If
problem persists, notify 3D Plus+ and request your
Field Engineer.

Error Message: Error in beam profile

Cause: Profiling did not complete properly.

Action: Make sure door is not ajar. Check laser power. If
problem persists, notify 3D Plus+ and request your
Field Engineer.

Error Message: Error in order of profiler pinholes

Cause: Profiling did not complete properly.

Action: Check laser power. If problem persists, notify 3D
Plus+ and request your Field Engineer.
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Error Message: Error in profiler pinhole order

Cause: Profiling did not complete properly.

Action: Check laser power. If problem persists, notify 3D
Plus+ and request your Field Engineer.

Error Message: Error in profile safety check

Cause: Profiling did not complete properly.

Action: Make sure door is not ajar. Check laser power. If
problem persists, notify 3D Plus+ and request your
Field Engineer.

Error Message: Error occurred while reading laser power.
Build will be aborted!

Cause: Probable cause, is the laser was unable to locate
the FAD sensor.

Action: Check that the safety shutter is open. If problem
persists, notify 3D Plus+ and request your Field
Engineer.

Error Message: Error while converting laser reply message

Cause: Potential laser hardware problem.

Action: Reboot, notify 3D Plus+ and request your Field
Engineer.

Error Message: Failed to create laser control object

Cause: Possible incorrect software installation.

Action: Reboot. If problem persists, reinstall your
Buildstation software.
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Error Message: Insufficient leveler range for preferred blade
gap.

Cause: Difference between physical and preferred blade
gaps is too great.

Action: Notify 3D Plus+ and request your Field Engineer.

Error Message: Invalid GEO file format

Cause: Corrupt GEO file.

Action: Notify 3D Plus+ and request your Field Engineer for
recalibration.

Error Message: IO3D kernel device driver is already open

Cause: Possible incorrect software installation.

Action: Reboot. If problem persists, reinstall your
Buildstation software.

Error Message: Job name already exists. Please verify name

Cause: A job with the same name already exists when
attempting to edit new Job�s name.

Action: Check to see if there is more than one job with the
same name.

Error Message: Laser does not support such function

Cause: Incorrect software installation.

Action: Reinstall with special care to choose the correct SLA
type.

Error Message: Laser failed to interpret command issued

Cause: Incorrect software installation.

Action: Reinstall with special care to choose the correct SLA
type.
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Error Message: Laser handshake error

Cause: Potential laser hardware problem.

Action: Reboot, notify 3D Plus+ and request your Field
Engineer.

Error Message: Laser security error

Cause: Potential laser hardware problem.

Action: Reboot, notify 3D Plus+ and request your Field
Engineer.

Error Message: Layer thickness out of range.

Cause: Bad instructions in BFF file.

Action: Reprepare file.

Error Message: Leveler calibration band out of range.

Cause: Difference between physical and preferred blade
gaps is too great.

Action: Notify 3D Plus+ and request your Field Engineer.

Error Message: Motor not initialized. Attempted to move to
position without first moving the motor to
its home position

Cause: An attempt was made to use the �Move To� function
without first moving the motor to its home position.

Action: Move to home position first.

Error Message: Move length not equal to requested length

Cause: Hardware problem (PC21 Indexer).

Action: Notify 3D Plus+ and request your Field Engineer.
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Error Message: No connection between PC host and DSO

Cause: Potential hardware problem.

Action: Reboot, notify 3D Plus+ and request your Field
Engineer.

Error Message: Number of sweeps out of range.

Cause: Bad instructions in BFF file.

Action: Reprepare file.

Error Message: PC21 Get position error

Cause: Potential hardware problem.

Action: Reboot, notify 3D Plus+ and request your Field
Engineer.

Error Message: PC21 Indexer Status failure

Cause: Potential hardware problem.

Action: Reboot, notify 3D Plus+ and request your Field
Engineer.

Error Message: Port selected for paging not found

Cause: Windows NT detected that there is no selected port.

Action: Check Windows NT configuration.

Error Message: Reading binary file error

Cause: Corrupt GEO file.

Action: Notify 3D Plus+ and request your Field Engineer for
recalibration.
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Error Message: Recovered from sweeper stall.

Cause: The SLA has recovered from a sweeper stall.

Action: If the reason is unknown, check the part for signs of
a blade crash and restart the build if all looks �OK�,
or end the build to do further investigation. If the
problem persists, notify 3D Plus+ and request your
Field Engineer.

Error Message: Resin volume adjustment failed.

Cause: Resin Refill System empty, (SLA 350, SLA 3500,
SLA 5000 & SLA 7000) or potential hardware
problem (all SLAs).

Action: Check Resin Refill container (SLA 350, SLA 3500,
SLA 5000 & SLA 7000). Replace with a full container
if needed. For potential hardware problems, (all
SLAs) Reboot, notify 3D Plus+ and request your
Field Engineer.

Error Message: Safety Shutter time out

Cause: Chamber door may be ajar.

Action: Make sure it is not ajar. If problem persists, notify 3D
Plus+ and request your Field Engineer.

Error Message: Sensor low error

Cause: Profiler did not acquire enough power.

Action: Notify 3D Plus+ and request your Field Engineer.

Error Message: Sensor saturation detected

Cause: Profiler received too much power.

Action: Notify 3D Plus+ and request your Field Engineer.
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Error Message: Sweeper failed to complete move. Check for
collision with part or table

Cause: Sweeper failed or stalled while attempting to
complete move. Possible collision with part or table.

Action: Check for collision with part or table.

Error Message: Sweeper gap or velocity out of range

Cause: Bad instructions in BFF file.

Action: Reprepare file.

Error Message: Sweeper not at home for part drain.

Cause: Potential hardware problem.

Action: Reboot, notify 3D Plus+ and request your Field
Engineer.

Error Message: The calculated elevator move is out of range.

Cause: Bad instructions in BFF file.

Action: Reprepare file. If problem persists, notify 3D Plus+
and request your Field Engineer.

Error Message: The drawing servo parameters file
�params.dat� is invalid

Cause: Possible incorrect software installation.

Action: Reboot. If problem persists, reinstall your
Buildstation software.
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Error Message: The elevator appears to be at both limits
simultaneously.

Cause: This might be caused by an interlock condition such
as the chamber door being open. Otherwise it might
be a hardware problem.

Action: Make sure the chamber door(s) are not open. If the
problem persists, notify 3D Plus+ and request your
Field Engineer.

Error Message: The recoater blade appears to be at both
limits simultaneously.

Cause: This might be caused by an interlock condition such
as the chamber door being open. Otherwise it might
be a hardware problem.

Action: Make sure the chamber door(s) are not open. If the
problem persists, notify 3D Plus+ and request your
Field Engineer.

Error Message: The registry value cannot be written

Cause: Possible incorrect software installation.

Action: Reboot. If problem persists, reinstall your
Buildstation software.

Error Message: There was trouble downloading the drawing
servo program �SERVO.OUT� to the drawing
servo system

Cause: Possible incorrect software installation.

Action: Reboot. If problem persists, reinstall your
Buildstation software.

Error Message: Timed out reading IDB-ready bit in PC21

Cause: Potential hardware problem.

Action: Reboot, notify 3D Plus+ and request your Field
Engineer.
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Error Message: Timed out reading ODB-ready bit

Cause: Potential hardware problem.

Action: Reboot, notify 3D Plus+ and request your Field
Engineer.

Error Message: Trouble reading level sensor.

Cause: Potential hardware problem.

Action: Reboot, notify 3D Plus+ and request your Field
Engineer.

Error Message: Unrecovered sweeper stall.

Cause: The sweeper has stalled and not recovered.

Action: Move the sweeper to the front of the vat. If the
reason is unknown, check the part for signs of a
blade crash and restart the build if all looks �OK�, or
end the build to do further investigation. If the
problem persists, notify 3D Plus+ and request your
Field Engineer.

Error Message: Value out of range

Cause: Incorrect software installation.

Action: Reinstall with special care to choose the correct SLA
type.

Error Message: Watch dog error

Cause: Vat jack hardware problem.

Action: Notify 3D Plus+ and request your Field Engineer.
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Appendix C.

Troubleshooting the Buildstation

The following problems can typically be solved using the solutions listed
here. If the problem is still unresolved, call 3D Plus+ Customer Service at
1-800-793-3669 (U. S. or Canada). From outside the U. S. and Canada, call
your local 3D Systems Representative.
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Build
S ymptom Cause S olution

Cross  section on 
Build screen is  
unrecognizable.

Sliced along the incorrect 
axis.

Res lice along the correct 
axis .

Supports  do not 
attach to the 
platform.

Build s tart pos ition is  too 
low.

Reset build start location 
of platform.

Insufficient cure depth 
values.

Prepare again us ing 
increased overcure 
amount.

Resin added on platform 
where part is  to be drawn.

Add res in in left rear 
corner of vat.

Build stops during 
recoating.

Autoleveling sys tem is at 
limits due to temperature 
change.

Add or remove res in.

Autoleveling sys tem is 
inoperative.

See Hardware section.

Heater is  turned OFF. Check the heater and res in 
temperature.

Res in leveling time 
between layers  is  
longer than 
expected.

Diode leveler is  out of 
adjutment.

Call 3D Field Service.
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Symptom Cause Solution

Layers  are 
unattached and float 
on the res in surface

The part is  incorrectly 
supported.

Redesign the supports.

Trapped volume. Decrease sweep velocity.

Insufficient cure depth. Prepare again with the 
proper overcure.

Blade gap out of 
adjus tment.

Call 3D Field Service.

Power failure. Res tart build with res tart 
option if the res in 
temperature is  correct.

Laser power fluctuations . Call 3D Field Service.

Blade gap percentage set 
incorrectly.

Prepare again with the 
correct percentage.

Laser is  off and the 
elevator continues .

Beam obstructed. Check the shutter.

Laser failure. Ensure the chamber door 
is  closed. Turn the laser 
on.

Call 3D Field Service.

Recoater blade s talled by 
hitting the part while 
moving across  the vat.

Prepare again with the 
proper recoating 
parameters.

Build stopped. Disconnected or defective 
cables .

Connect cables  and check 
quality of connection.

A mechanical or electrical 
compoment failure.

Call 3D Field Service.
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Network

Symptom Cause Solution

Network will not 
connect. 

Server not mounted. Mount W orkstation in 
DiskAccess  or PC-NFS 
configuration.

Hos ts  file has improper 
address.

Correct all computer hos ts  
files  so they match.

Works tation password 
changed.

Reconfigure DiskAccess 
or PC-NFS.

Entering incorrect remote 
computer file name.

Enter proper names .

Builds tation powered up 
before W orkstation.

Reboot PC after 
W orks tation has  s tarted. 

Cables  are too long. Check length of cables 
add repeaters if needed.

The network is  overloaded 
or too busy. 

Check the number of proc-
esses running. Try 
trans ferring the files at a 
later time.

No route path to 
Works tation.

Verify the network router 
configuration.

Files  take too long 
to trans fer.  

Incomplete s lice or 
converge file. 

Res lice with adequate disk 
space. Check file 
completion of (SLI) and 
(BFF) files in 3D 
Lightyear.
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Part Specific
S ymptom Cause S olution

Part is  miss ing the 
top layers . 

Bad CAD model. 
Intersecting parts are not 
Boolean.

Either Booleanize the .s tl 
files  or redes ign the part 
checking surfaces  and 
clos ing gaps . Use Tools, 
Verify STL.

Works tation ran out of 
disk space during s licing.

Clear up some disk space 
and prepare the s lice file 
again if it is  incomplete.

Stray or miss ing 
vectors. 

Interface limitations. Contact your CAD vendor 
for interface support.

.s tl file triangles are too 
narrow. 

Increase the s lice 
resolution or change the 
CAD .s tl resolution.  Use 
Tools , Verify STL.

Confused mirrors , 
incorrect movement 
parameters .

Reboot.

Max Draw Speed too high. Decrease Max Draw Speed 
under Build Job 
Parameters.

Cobwebs . Laser missed pinholes . Call 3D Field Service.

Confused mirrors , 
incorrect movement 
parameters .

Reboot and call 3D Field 
Service.

Recoater blade is  moving 
the part.

Prepare again with the 
proper recoating 
parameters. Increase 
number of supports .

Poor laser contras t ratio. Call 3D Field Service.
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S ymptom Cause S olution

Tags  (tiny bumps). Excess ive mirror drift. Call 3D Field Service.

Layers  shifted. Incorrect cure depth, 
improper recoating 
parameters.

Prepare again with the 
proper overcure and 
recoating parameters.

Improper supports . Redes ign the support 
structure.

Profiling errors Call 3D Field Service.

Layers  separated.   Improper hatch spacing 
and/or overcure amount.

Prepare again with the 
proper parameters .

Improper skin fills . Prepare again with the 
proper fill spacing.

Low or fluctuating laser 
power.

Call 3D Field Service.

Bad recoate parameters 
with Zephyr.

Prepare again with the 
proper parameters .

Flat surface is  not 
flat.

Overcure amount is  too 
large.     

Reprepare with the proper 
values .

Incorrect recoat 
parameters.

Prepare again with the 
proper parameters .

Beam diameter too large. Call 3D Field Service.

Part is  warped. Hatch spacing is  too close, 
or overcure too much or 
too little.

Reprepare with proper 
values .

Insufficient supports . Add more support 
structures .

W aited too long before 
pos t curing the part.

Post cure before part 
deforms  due to its  own 
weight.
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S ymptom Caus e S olution

Part became too hot in  the 
PCA .

Pos t cure with s hort 
burs ts  and allow cooling 
between exposures .

Incorrect cleaning solvent. Us e proper s olvent to  
minimize s welling.

Parts  are too dark 
(yellow).

Too much UV expos ure. Heat the part in  an oven 
set to approximately 65°C 
to 93°C (150°F to 200°F) 
for 10 to 30 minutes.

Part smells . Part not thoroughly rinsed 
of solvent.

Clean the part again.

Improper solvent used in 
post process ing.

Refer to cleaning and post 
process ing procedures.

Blis tering on upper 
surface.

Incorrect fill penetration. Increase overcure on fill.

Blis tering on bottom 
surface.

Ballooning of firs t few 
delicate layers .

Increase Z-W ait time for 
firs t few layers  of bottom 
surface.

Beam diameter too small. Call 3D Field Service.

Soft Parts . Hatch spacing too large. Decrease hatch spacing.

Incorrect hatch overcure. Consult Build-sty le 
Parameters.

Insufficient post cure. See part build ing 
techniques .

Resin parameters may not 
be set correctly.

Run W INDOW PANES 
from the AccuM ax 
TOOLKIT.

Incorrect res in file 
selected.

Select proper res in file.
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Index

A

AccuMax Peak Performance Toolkit 29
Adding a New Resin File 29
Adding Projects and Jobs 36
Adjust Resin Volume 78
Adjust Resin Volume button 95
Adjusting Parameters 45
Auto Drain 43

B

Bitmap Size 90
Border Speed 40
Build Job Options frame 17, 42
Build Job Parameters frame 19, 44
Build Job Project frame 16, 36
Build Platform 33
build platform 23
Build Status Frame 20
Build Toolbar

Pause Build button 93
Preview Build button 93
Restart Build button 93
Start Build button 93
Stop Build button 93

Build-Style Parameters 46

C

Choosing a Resin File 27
Completing the Build 41
Cursor 8
Customize 85

D

Delete 30
Deleting a Resin File 30
Dial-Up Networking (DUN) 71
Draw Speed Ceilings 45

E

Elevator Down button 94
Elevator Home button 94
Elevator Start Position 23
Elevator to Start Position button 94
Elevator Up button 94

F

Field Service 76
Fill Speed 40

G

Geometric Calibration File 31

H

Hatch Speed 40

I

Image frame 20, 88
Installing a Build Platform 33

L

Laser Power Limits 75
Launching the Buildstation 11
Level Resin 80
Level Resin button 95
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M

Main Menu Bar 14
Main Menu Functions 97

Build 101
Edit 98
File 97
Help 108
Setup 103
View 99
Window 106

Main Motion Toolbar 94
Adjust Resin Volume button 95
Elevator Down button 94
Elevator Home button 94
Elevator to Start Position 94
Elevator Up button 94
Level Resin button 95
Platform to Top button 94
Recoater Backward button 94
Recoater Forward button 94

Motion Control 23, 24, 33, 34, 63
Mouse 8

N

New Job 37
Number of Sweeps 41

O

Observing Build Progress 40
Other Motion Toolbar

Recoater Home button 95
Vat Down button 95
Vat Home button 95
Vat Up button 95

P

Part Copies 47
Add 49
Delete 49
Positioning 51
Spacing 50
Suppress Copy 51
Unsuppress button 57

Part Dimensions frame 18, 43
Pause Build button 52, 93
Pausing a Build 52
Platform to Top button 41, 94
Pointer 8
Pre Dip Delay 40
Preview Build button 93
Projects and Jobs 36

R

Recoater Backward button 94
recoater blade stall 53
recoater blade stall or blade crash 58
Recoater Forward button 94
Recoater Home button 95
Recovering the Recoater Blade to the front of

the Vat 58
Remote 60
Remote Access Service (RAS) 71
Resin File 27

Add New 29
Resize a frame 88
Restart Build button 54, 93
Restarting a Paused Build 52
Restarting a Stopped Build 54
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S

Scale Factors 46
Scroll Bars 89
SLA Hardware Reference Manual 33, 35
SLA Performance Characteristics 73
Start Build button 52, 93
Starting the Build 39
Status Bar 15
Stir Resin 81
Stop Build button 53, 93
Stopping a Build 53
Suppress Copy button 57
Suppressing a Copy 54, 57
Sweep Velocity 41
Symbols Used in this Guide 7
System Setup 21

T

Telephone 69
Telephone paging 71

Dial-Up Networking (DUN) 71
Remote Access Service (RAS) 71

Thermostat 21
Title Bar 14
Toolbars 15, 92, 93

Build Toolbar 93
Main Motion Toolbar 94
Motion Control Toolbar 96
Other Motion Toolbar 95, 96
Telephone Toolbar 96

Transferring a Buildfile 10

U

Unsuppress button 57
User Interface 13

Build Job Options frame 17
Build Job Parameters frame 19
Build Job Project frame 16
Build Status frame 20
Image frame 20
Main Menu Bar 14
Part Dimensions frame 18
Status Bar 15
Title Bar 14
Toolbars 15

V

Vat Down button 95
Vat Home button 95
Vat Up button 95

W

Write ABRA Log 83
Write Sensor Logs 84

Z

Z Build Range (CAD units) 46
Z Dip Distance 40
Z Level Wait 41
Zoom in 89
Zoom out 89
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